# Table of Contents

## Part I START

### 7

## Part II Help & Registration

1. Getting Started guide ........................................................................................................ 7
2. Online help ......................................................................................................................... 7
3. Checking for software updates .......................................................................................... 8
4. Registering product ............................................................................................................... 8

## Part III Workspace

1. Ribbon interface .................................................................................................................. 9
    Hiding & showing the ribbon .............................................................................................. 10
    Ribbon shortcuts .................................................................................................................. 11
2. Quick Access Toolbar ........................................................................................................ 11
3. Nitro PDF Button/File menu .............................................................................................. 11
4. Move & select ....................................................................................................................... 11
5. Zoom in & out ...................................................................................................................... 12
6. Page Display modes ............................................................................................................ 14
7. Rotating page view ............................................................................................................. 14
8. Comments & attachments ................................................................................................. 14
9. Document properties .......................................................................................................... 15
    Summary information ......................................................................................................... 15
    Initial View ......................................................................................................................... 16
    Fonts .................................................................................................................................. 17
    Security ............................................................................................................................. 17
10. Paging through document ................................................................................................. 17
11. Bookmarks and pages ....................................................................................................... 18
12. Searching text .................................................................................................................... 19

## Part IV Creating PDF

1. Fast PDF creation .............................................................................................................. 20
    One-click creation file type support .................................................................................. 20
2. Converting Microsoft Office files to PDF ......................................................................... 21
    Converting Microsoft Word files to PDF ........................................................................... 21
    Converting Microsoft Excel files to PDF ............................................................................ 22
    Converting Microsoft PowerPoint files to PDF ................................................................. 23
    Converting Microsoft Publisher files to PDF ...................................................................... 24
    Converting Microsoft Visio files to PDF ............................................................................ 24
    Microsoft Office add-in settings ....................................................................................... 25
3. Creating PDFs from any file .............................................................................................. 27

© 2008 Nitro PDF Software
| Part VII | Creating PDF | 3 |
|---------------------------------------------|----------------|
| 4 Creating PDF from screen captures          | 28             |
| 5 Creating PDF from scanner                  | 28             |
| 6 Creating new blank PDF files               | 29             |
| Part VI Combing files & assembling pages     | 32             |
| 1 Combining files to PDF                     | 33             |
| 2 Assembling pages                           | 33             |
| 3 Cropping or resizing pages                 | 34             |
| 4 Rotating pages                             | 34             |
| 5 Extracting pages                           | 34             |
| 6 Deleting pages                             | 35             |
| 7 Reordering & rearranging pages             | 35             |
| 8 Inserting pages                            | 35             |
| 9 Splitting pages                            | 36             |
| Split into groups of pages                   | 36             |
| Split by bookmarks                           | 36             |
| Split by page ranges                         | 36             |
| Part VII Editing                             | 37             |
| 1 Undo/redo edits                            | 38             |
| 2 Text                                       | 38             |
| Adding headers & footers                     | 39             |
| Adding Bates numbering                       | 40             |
| 3 Images                                     | 41             |
| Arranging images                             | 41             |
| Resizing and cropping images                 | 41             |
| Replacing images                             | 42             |
| Extracting images                            | 42             |
| Inserting images                             | 42             |
| Changing image color space                   | 42             |
| Deleting images                              | 43             |
| Watermarks                                   | 43             |
| 4 Optimizing & shrinking files               | 44             |
| 5 Attaching files                            | 44             |
| 6 Document properties                        | 44             |
| Document information or metadata             | 45             |
| Nitro PDF Driver settings                     | 27             |

| Part V Exporting from PDF                   | 29             |
| 1 Copying text                              | 29             |
| 2 Copying page snapshot                     | 30             |
| 3 Exporting PDF to Microsoft Word           | 30             |
| 4 Exporting PDF to Rich Text                | 31             |
| 5 Extracting images and text                | 32             |

© 2008 Nitro PDF Software
Part VIII  Interactivity  46

1 Bookmarks.................................................................................................................. 46
   Viewing and using bookmarks ..................................................................................... 47
   Creating bookmarks ..................................................................................................... 47
   Editing bookmarks ....................................................................................................... 48
   Automatic bookmark creation .................................................................................... 49

2 Links ............................................................................................................................... 52
   Adding links ................................................................................................................. 52
   Editing links .................................................................................................................. 53
   Automatic page number links ...................................................................................... 54
   Automatic keyword link creation ................................................................................ 54
   Creating web links from URLs ..................................................................................... 54

Part IX  Commenting  55

1 Adding sticky notes....................................................................................................... 55
2 Adding Text Boxes......................................................................................................... 55
3 Adding Call Outs............................................................................................................ 56
4 Highlighting text............................................................................................................ 57
5 Adding stamps............................................................................................................... 57
6 Markup with drawing tools.......................................................................................... 58
7 Attaching files............................................................................................................... 59
8 Managing & viewing comments..................................................................................... 59
   Sorting comments ....................................................................................................... 60
   Reply to comment ....................................................................................................... 60
   Hide all comments ...................................................................................................... 60
   Combine comments from multiple files ....................................................................... 60

Part X  Security  61

1 Permission settings....................................................................................................... 61
2 Password security......................................................................................................... 62
3 Certificate security....................................................................................................... 62
4 Security profiles............................................................................................................ 63
5 Digital IDs...................................................................................................................... 64
   My Digital IDs ............................................................................................................. 64
   Trusted contacts .......................................................................................................... 65

Part XI  Digital signatures  66

1 Using digital signatures................................................................................................ 66
   Customizing signature appearance .............................................................................. 67
2 Viewing and validating certificates and signatures..................................................... 68
3 Certifying PDF files....................................................................................................... 68
Part XII Forms

1 Filling forms .................................................................................................................. 70
2 Designing forms .................................................................................................................. 70
3 Using form field controls .................................................................................................. 71
   Form field attributes ......................................................................................................... 71
   Creating button fields ....................................................................................................... 73
   Creating check box fields ................................................................................................. 73
   Creating radio button fields ............................................................................................. 74
   Creating combo box fields ............................................................................................... 75
   Creating list box fields ..................................................................................................... 75
   Creating text fields ........................................................................................................... 76
   Creating signature fields ................................................................................................. 77
   Creating multiple fields ................................................................................................... 77
4 Setting tab order .................................................................................................................. 78
5 Editing, aligning and spacing multiple fields ..................................................................... 78
6 Reusing form field appearance settings ............................................................................ 79
7 Importing and exporting form data .................................................................................. 79
8 Resetting form data ........................................................................................................... 79
9 Submitting form data ......................................................................................................... 80
10 Showing/Hidden fields ...................................................................................................... 80
11 Calculating field data ......................................................................................................... 81
12 JavaScript .......................................................................................................................... 81
   Finding JavaScripts ............................................................................................................ 81
   Copying and pasting JavaScripts ....................................................................................... 82
   Using folder level JavaScript ............................................................................................. 82
   Writing document level script .......................................................................................... 83
   Writing calculation scripts ............................................................................................... 83
   Using Simplified field notation ....................................................................................... 83
   Using the JavaScript console ............................................................................................. 84
   Viewing output and JavaScript errors ................................................................................. 84
   Supported JavaScript Objects ............................................................................................ 84
   App object ......................................................................................................................... 84
   Doc object ........................................................................................................................ 85
   color object ....................................................................................................................... 87
   console object ................................................................................................................... 87
   event object ....................................................................................................................... 87
   Field object ....................................................................................................................... 88
   global object ....................................................................................................................... 90
   identity object .................................................................................................................. 91
   Link object ....................................................................................................................... 91
   this object ......................................................................................................................... 91
   util object ......................................................................................................................... 92

Part XIII Shortcuts

1 Viewing ............................................................................................................................... 92
2 Navigating ........................................................................................................................... 93
3 Editing ................................................................................................................................. 93
4 File ........................................................................................................................................... 94
5 Tools ........................................................................................................................................ 95
1. **Quick Start**

<table>
<thead>
<tr>
<th>Quick Start</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking at the workspace</td>
<td>Creating PDF</td>
</tr>
<tr>
<td>Key tools</td>
<td>Exporting from PDF</td>
</tr>
<tr>
<td>Viewing</td>
<td>Editing text, images and pages</td>
</tr>
<tr>
<td>Navigating</td>
<td>Securing, digitally signing, and certifying</td>
</tr>
<tr>
<td>Keyboard shortcuts</td>
<td>Commenting</td>
</tr>
<tr>
<td>Updating software</td>
<td>Bookmarks &amp; links</td>
</tr>
<tr>
<td>Registering your product</td>
<td>Forms</td>
</tr>
</tbody>
</table>

2. **Help & Registration**

Nitro PDF Professional includes a Help ribbon tab which brings together everything you’ll need to use, register and get help when using our software.

**To open the user guide:**
1. Do one of the following:
   - On the **Help** tab, in the **Help** group, click **User Guide**.
   - In the top right corner of the Nitro PDF Professional window, click the help button.

2.1 **Getting Started guide**

The Getting Started dialog gives you a fast way to learn about Nitro PDF Professional and how you can get started using the functionality you’re most interested in. The dialog is set to pop up automatically when you first open Nitro PDF Professional, but it can also be opened manually and reset to be permanently on or off.

**To open the Getting Started dialog:**
- On the **Help** tab, in the **Help** group, click **Getting Started**.

**To stop the Getting Started window from opening at startup:**
1. Open Nitro PDF Professional.
2. On the **Getting Started** dialog, in the bottom right corner, click the **Do not show at startup** checkbox.

2.2 **Online help**

To get online help using Nitro PDF Professional, visit the support section of the Nitro PDF web site. The
section includes an online product manual and a support section for registered users.

- **Knowledge Base.** Provides a repository for commonly asked questions and resolutions to common problems.
- **Priority support.** All registered users get full 14-day e-mail support to get you up and running.
- **Extended support.** To get extended support from the Nitro team, subscribe to ongoing support.

### 2.3 Checking for software updates

Nitro PDF Professional can be set up to automatically check for product updates or you can check for updates manually. By default, the Check for Updates preference checks for software updates once a day.

**To check for updates manually:**

- On the **Help** tab, in the **Product** group, click **Check For Updates**.

**To set whether to automatically check for updates and its frequency:**

1. Click the **Nitro PDF Button** 📋, and then click **Preferences**.
2. Click **Check For Updates**.
3. Click the setting to use.
4. Click **OK**.

### 2.4 Registering product

Nitro PDF Professional's free trial mode ends after 14-day's use. After that time you can continue to use the product in 'demo' mode, which means a watermark will be placed on each page in the documents. Purchasing Nitro Pro and then entering the license key you receive will stop the watermarks from appearing and will return the product to a fully-functional state.

**To register your Nitro PDF Professional:**

1. Do on of the following:
   - Re-open Nitro PDF Professional, click **Enter Serial**, and enter your details.
   - On the Help ribbon tab, in the Product group, click **License Information.** Click **Activate** and enter your details.

### 3. Workspace

Nitro PDF Professional 5 is a new interface, packed with tools and panes that help make working with PDF files easier. A good way to get up to speed with finding and using them is to familiarize yourself with the workspace.
1. **Nitro PDF Button.** Gives you access to standard file-related commands, such as open, close, save, and print.

2. **Quick Access Toolbar.** Keeps your favorite commands together in the one place.

3. **Ribbon.** Gives you quick access to most tasks and commands.

4. **Tools.** Home to the commonly used Hand, Zoom, Copy Text, and Edit tools.


6. **Comments & Attachments panes.** Central location to view all comments and attachments.

7. **Find.** Lets you search the current document for keywords.

8. **Navigate & Zoom.** Gives you quick access to viewing controls so you can move between pages, switch the Page Display mode, and change the magnification level.

9. **Information bar.** Displays important information about documents as they are opened.

### 3.1 Ribbon interface

The new look for Nitro PDF Professional 5 is based on the ‘ribbon’ interface first introduced with Microsoft Office 2007. The new way of working removes menus and toolbars, instead grouping related commands and tasks together on tabs. The new interface should make it quicker and easier for you to get things done.
1. **Tabs** are home to a set of task-related features.
2. **Groups** within each tab are home to closely related tasks and commands.
3. **Command** or **feature buttons** carry out a command or get you started with a task.

### 3.1.1 Hiding & showing the ribbon

If you want more space on your screen for viewing PDF files in Nitro then you can minimize the ribbon.

**Ribbon**

![Ribbon](image)

**Minimized ribbon**

![Minimized Ribbon](image)

There are three different display modes the ribbon supports.

1. **Always show** the ribbon.
2. **Always hide** the ribbon.
3. **Temporarily hide/show** the ribbon. This mode hides the commands away but lets you quickly access a command on a tab and then return to a view where the ribbon is minimized.

**To always show/hide the ribbon:**

1. Do one of the following:
   - Double-click on a tab (e.g. the **Home** tab).
   - Press CTRL+F1.
2. The ribbon should appear again or be hidden. To return to the preview state, perform step 1 again.

**To temporarily show a hidden ribbon tab:**

1. Click once on the ribbon tab (e.g. **Home**).
2. On the tab, click the command or tool you’d like to use.
3.1.2 Ribbon shortcuts

Like menus in older-style applications, all commands and tools in the ribbon have **Alt** shortcut keys for faster access. With the new ribbon design you can quickly display all the shortcuts so it’s very easy to learn.

**To access commands on the ribbon:**
1. Press the **Alt** key on your keyboard.
2. Press the key or keys on your keyboard to select the tab or command you’d like to use.

3.2 Quick Access Toolbar

The Quick Access Toolbar, as the name suggests, gives you easy access to your favorite tools. By default it includes common features such as Open, Save, Print, Undo and Redo, but you can customize it so that any command from any ribbon tab is accessible from there.

**To customize the Quick Access toolbar:**
1. Click the down arrow to the right of the Quick Access Toolbar.
2. Click **More Commands**.
3. In the **Choose commands from** list click the tab name to display its commands in the left pane.
4. In left pane, highlight the command and click **Add**.
5. Once finished, click **OK**.

3.3 Nitro PDF Button/File menu

The **Nitro PDF Button** that appears in the top left corner of the Nitro PDF Professional window replaces the **File menu** that is used on traditional application windows. The functionality remains essentially the same, with all the typical features such as Open, Close, Save, Email and Print available from there.

3.4 Move & select

The key tools for moving around the page and grabbing objects on them are all together in the Tools group, which appears at the far left of each ribbon tab.
• **Hand.** Allows you to grab the page and move around it.
• **Copy Text.** Allows you to select and then copy text for re-use in other applications.
• **Page Area Snapshot.** Lets you ‘capture’ any part of a page and then paste it as an image into another application.
• **Edit Text & Images.** Allows you to select text or graphic and make changes to it.
• **Edit Links.** Lets you select, edit and move links around.

### 3.5 Zoom in & out

Nitro PDF Professional includes tools for zooming in and out on the page, as well as zooming to preset magnification levels and other page fitting settings. You can view the pages in your PDF files at any magnification level between 12.5% and 1600%.

**Zoom In/Out**

These tools allow you to zoom in and out to particular magnification levels. Just click on the area of the page you want to move in or out from.

**To use the Zoom In/Out tool:**

1. Do one of the following:
   - On any ribbon tab, in the **Tools** group, select the **Zoom In** or **Zoom Out** tool.
Right-click on the page and click the **Zoom In** or **Zoom Out** option.

2. On the page, click where you want to zoom in or out.

**To switch between Zoom In and Zoom out:**
- When either zoom tool is selected, hold down CTRL and click on the page to do the opposite kind of zooming.

**Preset zoom levels**

The preset zoom values let you quickly switch to the most commonly used magnification levels. These include presets for 25%, 50%, 75%, 100%, 125%, 150%, 200%, 400%, 800%, and 1600%.

**To use the Zoom In/Out tool:**
1. Do one of the following:
   - If **Zoom In** or **Zoom Out** is already selected, then right-click and select the magnification level to move to.
   - On the ribbon tab, in the Tools group, click the arrow beneath the Zoom tool and click the magnification level to move to.

**Custom zoom level**

If you need to zoom to an exact magnification level.

**To zoom to an exact magnification level:**
1. In the bottom right corner of the Nitro PDF Professional window, click on the magnification percentage value.
2. In the list, click **Zoom to**.
3. Enter the magnification level.
4. Click **OK**.

**Zoom slider**

The slider is permanently visible in the bottom-right corner of the Nitro PDF Professional window and it gives you a quick and easy way to move in and out on the page.

**Fixed page views**

Has three commonly used pages views. **Actual Size** displays the page at its real size, or 100% zoom level. **Fit Width** makes the width of the page fill the width of the Document pane. **Fit Page** makes the whole page fit within the Document pane area, forcing both the page width and height within the area.

**To change the Page Display mode:**
1. Do one of the following:
   - On the **View** tab, in the **Make Page** group, click the magnification to use.
   - In the bottom corner of the Nitro PDF Professional window, click the **Make Page Zoom Level**.
3.6 Page Display modes

Nitro PDF Professional gives you several different ways to view pages. You can view them as pages, like one continuous scrollable page, or a mixture in which pages are displayed as a two-page spread side by side. The different modes suit different kinds of documents and tasks.

- **Single.** Displays one page at a time and treats the document as though it were a series of pages you move through.
- **Facing.** Displays two pages at a time, side by side as a spread.
- **Continuous.** Displays all pages in one continuous column and is scrollable much like a webpage.
- **Facing Continuous.** Displays all pages in two continuous vertical columns.

Fixed page views. Has three commonly used pages views. Actual Size displays the page at its real size, or 100% zoom level. Fit Width makes the width of the page fill the width of the Document panel. Fit Page makes the whole page fit within the Document panel view, forcing both the page width and height within the area.

**To change the Page Display mode:**
1. Do one of the following:
   - On the **View** tab, in the **Page Display** group, click the mode to use.
   - In the bottom corner of the Nitro PDF Professional window, click the **Page Display** button, and then click the mode to use.

3.7 Rotating page view

Nitro PDF Professional supports temporary page rotation and permanent page rotation. If you’re just viewing a document and want pages to be rotated temporarily so they’re easier to look at, you’ll need the rotate functionality in the View ribbon tab.

**To rotate pages temporarily:**
- On the **View** tab, in the **Rotate** group, click either **Right** or **Left**.

3.8 Comments & attachments

The Comments and Attachments panes give you a centralized place to see and organize all your annotations and file attachments.

**Comments pane**

The Comments pane lets you keep track of comments added to your PDF documents. The pane displays a
list of each comment, its type, reviewer name, date added, and the text included in any pop-up notes and text boxes.

To show or hide the Comments pane:
- On the Home ribbon tab, in the Show/Hide group, click the Comments checkbox.

Attachments pane

The Attachments pane gives you a central place to view, insert, delete and export any files that are attached to your PDF file.

To show or hide the Attachments pane:
- On the Home ribbon tab, in the Show/Hide group, click the Attachments checkbox.

3.9 Document properties

The document properties let you quickly find out more about a PDF—what created, how t will display when opened, how it is secured, what fonts it includes, and more.

To view the document properties:
1. Do one of the following:
   - Press CTRL+D.
   - In the Nitro PDF Button menu, click Document Properties.

3.9.1 Summary information

The document summary information fields in Nitro PDF Professional are useful for users who want to know more about a document, and they’re particularly useful for indexing your documents. With Nitro PDF Professional you can edit the document title, author, subject and keyword fields, as well as add your own custom metadata fields. The summary information fields include:
• **Title.** Editable information field used to display the document title.
• **Author.** Editable information field used to display the document author.
• **Subject.** Editable information field used to categorize the document.
• **Keywords.** Editable information field used to categorize the document.
• **Base URL.** Details the base URL for Web links in the PDF.
• **Creator.** Details the application the PDF was created from.
• **Producer.** Details the program used to create the PDF.
• **Optimized.** Details whether the PDF is optimized for use online. Documents load faster, page by page online, when optimized.
• **PDF Version.** Details what version PDF has been created. The version is determined by the PDF specification. Nitro PDF Professional can make PDFs that adhere to the 1.3, 1.4, or 1.5 PDF specifications.
• **Number of Pages.** Details how many pages the document contains.
• **Custom Defined Fields.** Unlimited fields that can be used for customizable categorization.
• **Page dimensions.** Displays the height and width of the pages used in the PDF. You can change units to measure the page via the preferences.

**To edit document information fields:**
1. Do one of the following:
   - Press CTRL+D.
   - In the Nitro PDF Button menu, click **Document Properties**.
2. Enter your text into the fields you want to update.
3. Click **OK**.

**To add or edit custom information fields:**
1. Do one of the following:
   - Press CTRL+D.
   - In the Nitro PDF Button menu, click **Document Properties**.
2. Click **Edit**.
3. Enter a name for the custom field and a value.
4. Click **Add**, and then **OK**.

### 3.9.2 Initial View

You can set PDF documents to display in many different ways depending how your file will be used by recipients. For example, if your document contained bookmarks and you wanted them to be easily accessible, you could set the document to open with the Bookmarks pane already displayed.

• **Navigation.** Sets whether a navigation pane, including Bookmarks and Pages, is displayed when the file is opened.
• **Go to Page.** Specifies at which page to open the PDF.
• **Layout.** Sets the page mode to open with, Single, Continuous, Facing, or Facing Continuous. Single and Facing modes treat the document as though it were a series of pages that you move through. The other modes work more like the document is one large column that you scroll through (like a web page).
• **Zoom.** Sets the default magnification level. Choose from a particular magnification percentage, or choose the Fit Width, Fit Height or Visible Content settings.
• **Window Title.** Sets what is displayed in the title bar of Nitro PDF Professional. Either the file name or the document title field.
• **Hide Menu Bar.** Stops the menu (the Menu Bar) from appearing when the PDF is opened in Adobe Acrobat or Adobe Reader.
• **Hide Toolbar.** Stops all toolbars from appearing when the PDF is opened in Adobe Acrobat or Adobe Reader.
Reader.

- **Hide Window Controls.** Hides left panel and status bar when the PDF is opened in Adobe Acrobat or Adobe Reader.

**To view and edit initial view properties:**

1. Do one of the following:
   - Press CTRL+D.
   - In the **Nitro PDF Button** menu, click **Document Properties**.
2. Click the **Initial View** tab.
3. Select the settings to use, and then click **OK**.
4. Save the PDF.

**3.9.3 Fonts**

Nitro PDF Professional let’s you get information on all the fonts used in a PDF file. The font summary information is included in the Document Properties dialog.

**To view all fonts in a document:**

1. Do one of the following:
   - Press CTRL+D.
   - In the **Nitro PDF Button** menu, click **Document Properties**.
2. Click the **Fonts** tab.

**3.9.4 Security**

A summary of all security settings is found in the Document Properties dialog. From there, you can also modify the settings if you have the rights to do so.

**To view security settings:**

1. Do one of the following:
   - Press CTRL+D.
   - In the **Nitro PDF Button** menu, click **Document Properties**.
2. Click the **Security** tab.
3. To edit the settings, click the **Security method** list, modify the settings, and then click **OK**.

**3.10 Paging through document**

To page through a document you can use the standard keys and mouse functionality you find in most applications, including arrows and page up/down keys on your keyboard, and the scroll wheel on your mouse.

In addition, Nitro PDF Professional includes a set of paging controls along the bottom of the Nitro PDF Professional window.

These paging controls include:

- **First/Last Page.** To go straight to the start or end of a document.
- **Next/Previous Page.** To go one page back or forward one page in a document.
• **Next/Previous History.** To move backwards and forwards between each view change you make when looking at a PDF. A history view might include movements around a page, moves between pages, changes in magnification level, and more.

• **Go to page number.** Lets you enter the exact page number to go to.

### To go to the start or end of a document:
1. Do one of the following:
   • Along the bottom of the Nitro PDF Professional window, click the **First Page** or **Last Page** button.
   • On your keyboard, press the Home or End key.

### To go to the next or previous page:
1. Do one of the following:
   • Along the bottom of the Nitro PDF Professional window, click the **Next Page** or **Previous Page** button.
   • On your keyboard, press CTRL+Page Down or CTRL+Page Up.

### To go to a specific page:
- Along the bottom of the Nitro PDF Professional window, in the page numbering field, type a page number, and then press Enter.

### To go to the previous or next view:
1. Do one of the following:
   • Along the bottom of the Nitro PDF Professional window, click the **Next Page** or **Previous Page** button.
   • On your keyboard, press CTRL+> or CTRL+<.

3.11 **Bookmarks and pages**

The Bookmarks and Pages panes give you additional ways to navigate around documents. Both appear down the left side of Nitro PDF Professional.

**Bookmarks pane**

Allows you to display text bookmarks that when clicked perform an action, such as going to a page in the document, opening a file, or going to a web page.
To show or hide the Bookmarks pane:
- On the Home ribbon tab, in the Show/Hide group, click the Bookmarks checkbox.

Pages pane

The Pages pane displays a thumbnail size of each page in a document, enabling you to quickly move to the page you are looking for. You can also use the pane to rearrange the order of the pages in your document – just right-click on the thumbnail page and choose from options such as replace, delete, extract, crop and rotate pages.

To show or hide the Pages pane:
- On the Home ribbon tab, in the Show/Hide group, click the Pages checkbox.

3.12 Searching text

To search for a word or phrase in a PDF file you can use the Find box, which appears in the bottom-right corner of Nitro PDF Professional window. To narrow your search to case-sensitive or whole words, click the down arrow next to the search box.

To find text:
1. Do one of the following:
   - Press CTRL+F.
   - On the Home ribbon, in the Search group, click Find.
2. In the Find box, type in your search phrase, and then press Enter.
3. To search for the next or previous occurrence of a phrase in the document, click the Find Previous.
or Find Next buttons to the right of the Find box.

Tip: To stop a text search from continuing, press the Escape key.

4. Creating PDF

Nitro PDF Professional makes creating PDF documents simple and streamlined. You can quickly convert most common files with one click (including files open in Microsoft Word, Excel, and PowerPoint), and convert any other file type just by printing it to PDF.

- Create PDF quickly
- Create PDF from Microsoft Office
- Create PDF from any file
- Create PDF from screen captures
- Create PDF from scanner

To learn about combining files, see the Combining files and assembling pages section.

4.1 Fast PDF creation

For most commonly used file types (such as Microsoft Word, Excel, and PowerPoint), Nitro PDF Professional enables you to convert them to PDF quickly and with a minimal effort. There are a variety of ways to do the conversion, and best of all you can convert more than one file in the one go.

To create a PDF with one click:

- In the folder that contains the file, left-click the file and drag it on to the Nitro PDF Professional desktop icon.

To convert files to PDF from a folder or the desktop:

1. Open the folder that contains the files you want to convert.
2. Left-click the file you want to select. To select more than one file, hold down CTRL as you left-click.
3. Right-click, and then click Convert To PDF.

To convert files to PDF in Nitro PDF Professional:

1. On the Home tab, in the Convert group, click Create PDF.
2. On the Create PDF dialog, click the Add Files button, and then select the files to convert.
3. In the Make PDF files list do one of the following, depending on whether file size or print quality is more important to you:
   - If the document requires high print quality, click Print-ready.
   - If the print quality is less important than file size, click Office-ready.
   - If a small file size is the most important quality, click Web-ready.
4. In the Save PDF to list, select the location you want to save the files to.
5. Click Create.

4.1.1 One-click creation file type support

You can quickly convert most commonly used file types by dragging and dropping them on to the Nitro PDF Professional desktop icon or by opening the Create PDF dialog from the Home tab. File types supported

© 2008 Nitro PDF Software
include:

<table>
<thead>
<tr>
<th>Documents</th>
<th>Graphics</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Microsoft Word (.DOC, .DOCX)</td>
<td>• Bitmap (.BMP)</td>
</tr>
<tr>
<td>• Microsoft Excel (.XLS, .XLSX)</td>
<td>• GIF (.GIF)</td>
</tr>
<tr>
<td>• Microsoft PowerPoint (.PPT, .PPTX)</td>
<td>• JPEG (.JPG, .JPEG, .JPE)</td>
</tr>
<tr>
<td>• Microsoft Publisher (.PUB)</td>
<td>• JPEG2000 (.JPF, .JP2, .J2K)</td>
</tr>
<tr>
<td>• Microsoft Visio (.VSD)</td>
<td>• PNG (.PNG)</td>
</tr>
<tr>
<td>• HTML (.HTML, .HTM)</td>
<td>• Metafile (.WMF, .EMF)</td>
</tr>
<tr>
<td>• WordPerfect (.WPD)</td>
<td>• TIFF (.TIF, .TIFF)</td>
</tr>
<tr>
<td>• Rich Text (RTF)</td>
<td></td>
</tr>
<tr>
<td>• Text (.TXT)</td>
<td></td>
</tr>
<tr>
<td>• Bitmap (.BMP)</td>
<td></td>
</tr>
<tr>
<td>• GIF (.GIF)</td>
<td></td>
</tr>
<tr>
<td>• JPEG (.JPG, .JPEG, .JPE)</td>
<td></td>
</tr>
<tr>
<td>• JPEG2000 (.JPF, .JP2, .J2K)</td>
<td></td>
</tr>
<tr>
<td>• PNG (.PNG)</td>
<td></td>
</tr>
<tr>
<td>• Metafile (.WMF, .EMF)</td>
<td></td>
</tr>
<tr>
<td>• TIFF (.TIF, .TIFF)</td>
<td></td>
</tr>
</tbody>
</table>

4.2 Converting Microsoft Office files to PDF

As well as one-click creation in Microsoft Word, Excel, and PowerPoint, Nitro PDF Professional includes Office add-ins with advanced conversion settings to apply bookmarks, links, document property information, and security during creation.

- Converting Microsoft Word files to PDF
- Converting Microsoft Excel files to PDF
- Converting Microsoft PowerPoint files to PDF
- Converting Microsoft Visio files to PDF
- Converting Microsoft Publisher files to PDF

4.2.1 Converting Microsoft Word files to PDF

Nitro PDF Professional enables you to create more intelligent PDFs by automatically adding navigation, document information, security, and more during creation. If you're using Office 2007, Nitro Pro includes additional features that make it quicker and easier to secure and distribute files, as well as add choose the appropriate intelligence settings.

Tip: see the Microsoft Office add-ins settings help topic for information on how you can customize the PDF files you create from Word.

Using Microsoft Word 2007

To create a PDF:
- On the Nitro PDF tab, in the Create PDF group, click Create PDF.
- On the Nitro PDF tab, in the Create PDF group, click Create and Email.

To create a secure PDF:
- On the Nitro PDF tab, in the Secure PDF group, click Secure PDF.
- On the Nitro PDF tab, in the Secure PDF group, click Secure and Email.

To create an intelligent PDF:
1. On the Nitro PDF tab, in the Settings group, click and select the settings to use.
2. Optionally, in the Settings group, click More Settings and choose extra settings.
3. On the Nitro PDF tab, in the Create PDF group, click Create PDF.

**Using Microsoft Word 2000-2003**

**To create a PDF:**
- Click Convert to PDF.
- Click Convert to PDF and Email.

**To create an intelligent PDF:**
1. Click Nitro PDF Professional Word Settings.
2. In the Settings, Security, and Bookmarks tabs, click the options you want to use.
3. Click OK.

**4.2.2 Converting Microsoft Excel files to PDF**

Nitro PDF Professional includes a macro for Microsoft Excel that lets you convert to PDF from the toolbar in Excel. (See the Microsoft Office add-ins settings help topic for full information on how you can customize creation from Excel.)

**Tip:** To convert the whole workbook, make sure you have the setting turned on in the Nitro PDF Professional menu.

**Using Microsoft Excel 2007**

**To create a PDF:**
- On the Nitro PDF tab, in the Create PDF group, click Create PDF.
- On the Nitro PDF tab, in the Create PDF group, click Create and Email.

**To create a secure PDF:**
- On the Nitro PDF tab, in the Secure PDF group, click Secure PDF.
- On the Nitro PDF tab, in the Secure PDF group, click Secure and Email.

**To create an intelligent PDF:**
1. On the Nitro PDF tab, in the Settings group, click and select the settings to use.
2. Optionally, in the Settings group, click More Settings and choose extra settings.
3. On the Nitro PDF tab, in the Create PDF group, click Create PDF.

**Using Microsoft Excel 2000-2003**

**To create a PDF:**
To create an intelligent PDF:
1. Click Nitro PDF Professional Word Settings.
2. In the Settings, Security, and Bookmarks tabs, click the options you want to use.
3. Click OK.

4.2.3 Converting Microsoft PowerPoint files to PDF

Nitro PDF Professional includes a macro for Microsoft PowerPoint that lets you convert to PDF from the toolbar in Excel. (See the Microsoft Office add-ins settings help topic for full information on how you can customize creation from PowerPoint.)

Using Microsoft PowerPoint 2007

To create a PDF:
- On the Nitro PDF tab, in the Create PDF group, click Create PDF.
- On the Nitro PDF tab, in the Create PDF group, click Create and Email.

To create a secure PDF:
- On the Nitro PDF tab, in the Secure PDF group, click Secure PDF.
- On the Nitro PDF tab, in the Secure PDF group, click Secure and Email.

To create an intelligent PDF:
1. On the Nitro PDF tab, in the Settings group, click and select the settings to use.
2. Optionally, in the Settings group, click More Settings and choose extra settings.
3. On the Nitro PDF tab, in the Create PDF group, click Create PDF.

Using Microsoft PowerPoint 2000-2003

To create a PDF:
- Click Convert to PDF.
- Click Convert to PDF and Email.

To create an intelligent PDF:
1. Click Nitro PDF Professional Word Settings.
2. In the Settings, Security, and Bookmarks tabs, click the options you want to use.
3. Click OK.
4.2.4 Converting Microsoft Publisher files to PDF

You can convert Microsoft Publisher files to PDF from within the Publisher application, via your desktop, or with the Create PDF dialog in Nitro PDF Professional.

**How to create PDF files from Microsoft Publisher:**
1. Open the PUB file in Microsoft Publisher.
2. Click the **Print** option.
3. In the Printer list, choose **Nitro PDF Driver**, and then click **OK**.
4. In the Select PDF Output Filename dialog, do any of the following:
   - Specify a name and a location
   - Choose from the **Post Process** list.
   - Click **Properties** and configure the PDF conversion settings.
5. Click **Save**.

**How to convert a Publisher file directly from a folder:**
1. Do one of the following:
   - Drag the file onto the Nitro PDF Professional desktop icon.
   - Right-click on the file to convert, and then click **Convert to PDF**.

**How to batch convert Publisher files to PDF:**
1. Do one of the following:
   - In the folder containing the PUB files, select them, right-click and then choose **Convert to PDF**.
   - In Nitro PDF Professional, on the **Home** tab, in the **Convert** group, click **Create PDF**. Click **Add Files** and select the PUB files to convert.
2. In the **Make PDF files** list do one of the following, depending on whether file size or print quality is more important to you:
   - If the document requires high print quality, click **Print-ready**.
   - If the print quality is less important than file size, click **Office-ready**.
   - If a small file size is the most important quality, click **Web-ready**.
3. In the **Save PDF to** list, select the location you want to save the files to.
4. Click **Create**.

4.2.5 Converting Microsoft Visio files to PDF

You can convert Microsoft Visio files to PDF from within the Visio application, via your desktop, or with the Create PDF dialog in Nitro PDF Professional.

**How to create PDF files from Microsoft Visio:**
1. Open the VSD file in Microsoft Visio.
2. Click the **Print** option.
3. In the Printer list, choose **Nitro PDF Driver**, and then click **OK**.
4. In the Select PDF Output Filename dialog, do any of the following:
   - Specify a name and a location
   - Choose from the **Post Process** list.
   - Click **Properties** and configure the PDF conversion settings.
5. Click **Save**.
How to convert a Visio file directly from a folder:
1. Do one of the following:
   - Drag the file onto the Nitro PDF Professional desktop icon.
   - Right-click on the file to convert, and then click Convert to PDF.

How to batch convert Visio files to PDF:
1. Do one of the following:
   - In the folder containing the VSD files, select them, right-click and then choose Convert to PDF.
   - In Nitro PDF Professional, on the Home tab, in the Convert group, click Create PDF. Click Add Files and select the PUB files to convert.
2. In the Make PDF files list do one of the following, depending on whether file size or print quality is more important to you:
   - If the document requires high print quality, click Print-ready.
   - If the print quality is less important than file size, click Office-ready.
   - If a small file size is the most important quality, click Web-ready.
3. In the Save PDF to list, select the location you want to save the files to.
4. Click Create.

4.2.6 Microsoft Office add-in settings

The Microsoft Office add-ins give you additional controls over the PDF files you produce, including security, improved navigation with bookmarks and hyperlinks, pages sizes, image compression, and much more. The settings vary based on the Office application you are using.

To modify the PDF conversion settings:

For Microsoft Office 2007:
1. On the Nitro PDF tab, in the Settings group, click and select the settings to use.
2. Optionally, in the Settings group, click More Settings and choose extra settings.

For Microsoft Office 2000-2003:
1. Click the Nitro PDF: Nitro PDF Settings toolbar button
2. Modify the settings and click OK.

The icons in the table below show which Microsoft Office applications (Word, Excel, and PowerPoint) support the feature.

<table>
<thead>
<tr>
<th>General settings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open PDF file after creation</td>
<td>Opens the PDF once it has been created.</td>
</tr>
<tr>
<td>Convert document summary</td>
<td>Imports document properties such as Author, Title, Subject, and more into the PDF.</td>
</tr>
<tr>
<td>Prompt for file name</td>
<td>Pops up a dialog to rename the PDF before saving it.</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Add links to PDF</td>
<td>Converts all active links in the file to active hyperlinks in the PDF file.</td>
</tr>
<tr>
<td>Include document revisions</td>
<td>Converts all document markups so they are visible in the PDF.</td>
</tr>
<tr>
<td>Attach source file</td>
<td>Attaches the original Microsoft Office file inside the PDF, which can then be opened and edited by the recipient.</td>
</tr>
<tr>
<td>Print all sheets</td>
<td>Converts all sheets in a spreadsheet to a PDF file.</td>
</tr>
<tr>
<td>Add bookmarks to PDF</td>
<td>Automatically creates bookmarks for each sheet in an Excel spreadsheet, or slide in a PowerPoint presentation. (For more advanced bookmark creation in Microsoft Word, see below.)</td>
</tr>
<tr>
<td>Frame slides</td>
<td>Places a frame around each slide.</td>
</tr>
<tr>
<td>Layout slides</td>
<td>Allows you to layout more than one slide per page in your PDF, as well as displaying your PowerPoint notes beneath each slide in the PDF.</td>
</tr>
</tbody>
</table>

### Advanced settings

<table>
<thead>
<tr>
<th>Page</th>
<th>Lets you set the page orientation and page size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Lets you set how to handle fonts. Embedding all fonts will increase the size but will allow more advanced editing if required. Embedding a subset of the fonts will look exactly the same as a PDF with all fonts embedded, it will be smaller in size, however the file could become problematic if a user needs to edit the text in the PDF. Not embedding fonts may mean that the PDF file does not look the same for all users – only users having all the fonts installed that were used in the source file will see the exact same looking PDF file. If this option is selected then you should make use of the font substitution settings to ensure text can at least be read.</td>
</tr>
<tr>
<td>Image</td>
<td>The image settings allow you to compress images to make a smaller PDF file. You should experiment to determine which method gives you the best combination of quality and file size. If you want to compress documents with rich graphics like photos and gradient-heavy images, use one of the JPEG settings.</td>
</tr>
</tbody>
</table>
4.3 Creating PDFs from any file

Nitro PDF Professional lets you create PDF files from any application that can print, meaning you can create PDFs from hundreds of different types of files. Just start your application as normal, open the file you want to convert, and then print.

To create a PDF from a file:
1. Open the file in its application.
2. Click the Print option.
3. In the Printer list, choose Nitro PDF Driver, and then click OK.
4. In the Select PDF Output Filename dialog, do any of the following:
   - Specify a name and a location
   - Choose from the Post Process list.
   - Click Properties and configure the PDF conversion settings.
5. Click Save.

4.3.1 Nitro PDF Driver settings

The Nitro PDF Professional Driver settings dialog gives you advanced control over the PDF files you create. The settings include:

- **Page size and rotation.** Sets the size and orientation of the pages.
- **Security & digital signatures.** Applies digital signatures to certify documents and password-based controls, including the limiting of print, copying and extracting, form filling, commenting and more.
- **Watermarks or stamps.** Applies text- and/or image-based watermarks and stamps to pages.
- **Fonts.** Controls whether to embed particular fonts or not, and whether to embed font subsets.
- **Document view options.** Sets whether to display the Bookmarks, Pages, Layers, or Attachment panes when opening a PDF, as well as the magnification level to use.
- **Interface options.** Sets whether the menu, toolbar, and so on should be displayed when a PDF is opened.
- **Document information (metadata).** Sets the document title, author, subject, and keywords.

To change Nitro PDF Professional Driver settings:
1. Open the print dialog.
2. In the Printer list, choose Nitro PDF Driver, and then click Properties.
3. Choose the options you want, and then click OK.

4.4 Creating PDF from screen captures

Nitro PDF Professional lets you create PDFs directly from your screen captures or ‘screenshots.’ Taking captures of your computer screen and then putting them straight into Nitro PDF Professional works particularly well when you want to add comments or drawing markups to the image you’ve captured.

To create a PDF from a screen capture:
1. Press the Print Screen key.
2. On the Home tab, in the Convert group, click the arrow below Create PDF.
3. Click Create PDF from Clipboard.

4.5 Creating PDF from scanner

Nitro PDF Professional provides you with an easy way to convert your paper documents to digital form for easier storage and access. Depending on the type of scanner you have, you will be able to convert pages one at a time, or do whole collections of pages in the one process. If you need to, you can also merge documents as you go to create the one complete PDF document.

To scan paper documents to PDF:
1. On the Home tab, in the Convert group, click the arrow below Create PDF.
2. Click Create PDF From Scanner.
3. In the Create PDF From Scanner dialog, select your scanner, the sheets to scan, image compression, and then specify the destination.
4. Click Scan to open your default scanning software.
5. Select the mode of scanning—color, grayscale, or monochrome/black-and-white.
6. Select the menu command to return to Nitro PDF Professional.
7. Select the Finish option to end your scanning job, or select the Scan front of sheet two to continue scanning.

4.5.1 Image compression settings

When scanning to PDF with Nitro PDF Professional, the type of compression used—color, grayscale, or monochrome—is determined by the output setting you select in your default scanning software. Therefore, if you intend to do a color scan, you can just leave the leave the Monochrome list setting as None.

- **Compression level slider.** The slider gives you quick control over how much compression to apply to your scanned pages, with the basic principle being that the lower quality you choose, the less dots per inch (dpi) and the smaller the file size will be. Approximately 50% will compress images to 96 DPI (fine for viewing on-screen), 60-70% will compress them to 150 DPI (fine for printing), 80+% will compress them to 300 DPI or higher (reasonable for high quality printing and archiving).
- **JPEG Compression.** Designed for photos and other graphics with very smooth and detailed tone changes.
- **CCITT Group 4 Compression.** Designed for monochrome or black-and-white images, it suits the scanning of plain text documents, faxes, and so on.
- **JBIG2 Compression.** Designed for monochrome or black-and white images, it suits the scanning of plain text documents, faxes, and so on. Pages scanned with JBIG2 compression tend to be smaller than CCITT Group 4 pages, but they take longer to generate.
4.6 Creating new blank PDF files

Should the need arise, you can quickly and easily create a blank PDF file in Nitro PDF Professional. Why would you ever want to create a blank PDF file? For form designers, in particular, it is a useful way to work on a form without distractions. Once the form is designed, the page(s) beneath the form fields can be replaced with the correct ones.

To create a blank PDF file:
- Click the Nitro PDF Button and then click New.

5. Exporting from PDF

Nitro PDF Professional includes tools to export PDF files so you can re-use the content in applications such as Microsoft Word, WordPerfect, Open Office and more. You can re-save files as DOC, RTF, TXT and when extracting images, as JPG or PNG. In addition, you can copy text and images directly from the pages in your PDF files.

- **Copy Text tool.** Copy text from pages and reuse in other applications.
- **Page Snapshot tool.** Capture an image of an area of the page and paste into another application.
- **PDF to Word.** Convert files to .DOC format for re-purposing in Microsoft Word.
- **PDF to Rich Text.** Convert files to RTF format for re-purposing in WordPerfect, Open Office and more.
- **Extract all text & images.** Extract each image as an individual file and extract all text to a plain text file.

Tip: The preferences in Nitro PDF Professional let you configure the default settings to use when exporting and copying. Go to Nitro PDF Button > Nitro PDF Preferences to set them.

5.1 Copying text

With Nitro PDF Professional it’s easy to copy blocks of text out of PDF documents and reuse them in other applications like Microsoft Word, Excel and WordPerfect. The Copy Text tool enables you to copy the text without or with text properties intact — including font type, size and color.

To copy text from a page:
1. On the Home tab, in the Tools group, click Copy Text.
2. Highlight text on the page and do either of the following:
   - Press CTRL+C.
   - Right-click and click Copy.
3. Paste the text into another application.

To copy all text from a page:
1. On the Home tab, in the Tools group, click Copy Text.
2. Do either of the following:
   - Press CTRL+A.
   - Right-click and click Select All.
3. Paste the text into another application.
To highlight and comment on text:
1. Right-click and click one of Highlight Text, Underline Text, Cross Out Text, or Add Note to Text options.
2. To add feedback to the text highlighting, press CTRL and double-click on the highlighted area.

Copying page snapshot

With Nitro PDF Professional it’s easy to capture a section of a PDF page (both text and graphics) and then paste the image in another application like Microsoft Word, PowerPoint, Paint, or Photoshop. You can even copy a section of a page and create a new PDF from it using the Create PDF from Clipboard tool.

To copy a snapshot of page content:
1. On the Home tab, in the Tools group, click the arrow below Copy Text.
2. Click Page Area Snapshot.
3. Draw a rectangle around the area of the page to copy.
4. Click OK.
5. Paste the image into another application.

Exporting PDF to Microsoft Word

Nitro PDF Professional’s export functionality lets you convert PDF files into the DOC format so you can re-purpose your content in Microsoft Word. The functionality lets you export a range of pages, whole files, or whole collections of files in the one task.

Note: It’s technically impossible to convert a PDF to a Word file so that the layout and formatting is exactly the same. Nitro PDF Professional does its best to provide you with a reusable Word file that retains the look and feel of the original PDF document.

Export settings

There are several settings that give you control over the output Nitro PDF Professional produces.

- **Images.** Lets you export bitmap-based images, set the dots per inch (dpi) of the extracted images, and specify whether to extract them as JPEG or PNG images.
- **Lines & shapes.** Lets you export vector- or path-based graphics. These are often used in logos, charts, table, and drawing shapes.
- **Metadata.** Lets you export the document title, author, subject and keyword property fields to the same fields in the DOC file.
- **Page range.** Lets you choose between exporting a specific range of pages or all pages.

To export PDF to Microsoft Word:
1. Do one of the following:
   - On the Home tab, in the Export group, click PDF to Word.
   - Click the Nitro PDF Button, click the Export slideout, and then click PDF to Word.
2. Choose your output settings and then click Convert.
3. Optionally, click the Choose Pages button to limit the conversion to a specific range of pages.
To export a batch of PDF files to Microsoft Word:

1. On the Home tab, in the Export group, click the arrow beneath PDF to Word and then click Convert Multiple Documents.
2. Choose your output settings, and then click Convert.

To set the PDF to Word conversion preferences:

1. Click the Nitro PDF Button, and then click Nitro PDF Preferences.
2. In the Convert PDF to preferences, click Word & Rich Text.
3. Choose your settings and then click OK.

Exporting PDF to Rich Text

Nitro PDF Professional’s export functionality lets you convert PDF files into the RTF format so you can re-purpose your content in WordPerfect, Open Office or another word processing application. The functionality lets you export a range of pages, whole files, or whole collections of files in the one task.

Note: It’s technically impossible to convert a PDF to a rich text file so that the layout and formatting is exactly the same. Nitro PDF Professional does its best to provide you with a reusable rich text file that retains the look and feel of the original PDF document.

Export settings

There are several settings that give you control over the output Nitro PDF Professional produces.

- **Images**: Lets you export bitmap-based images, set the dots per inch (dpi) of the extracted images, and specify whether to extract them as JPEG or PNG images.
- **Lines & shapes**: Lets you export vector- or path-based graphics. These are often used in logos, charts, table, and drawing shapes.
- **Metadata**: Lets you export the document title, author, subject and keyword property fields to the same fields in the RTF file.
- **Page range**: Lets you choose between exporting a specific range of pages or all pages.

To export PDF to rich text:

1. Do one of the following:
   - Click the Nitro PDF Button, click the Export slideout, and then click PDF to Rich Text.
2. Choose your output settings and then click Convert.
3. Optionally, click the Choose Pages button to limit the conversion to a specific range of pages.

To export a batch of PDF files to rich text:

1. On the Home tab, in the Export group, click the arrow beneath Rich Text and then click Convert Multiple Documents.
2. Choose your output settings, and then click Convert.

To set the PDF to Word conversion preferences:

1. Click the Nitro PDF Button, and then click Nitro PDF Preferences.
2. In the Convert PDF to preferences, click Word & Rich Text.
3. Choose your settings and then click OK.

5.5 Extracting images and text

The export text & images functionality lets you quickly extract all text and images from your PDF files. The output places all the text content into a plain text file and extracts each image to a separate JPEG or PNG file, depending on the type you chose. The functionality has settings for controlling the output, including:

- **Image quality and type.** Lets you change the dots per inch (dpi) of the images when extracting, as well as exporting images as JPEG or PNG files.
- **Detect paragraphs.** Allows you to wrap paragraph lines together, making the text content easier to re-purpose. If this setting is not turned on, a line break is added at the end of each line where the break appears in the PDF file.

**To extract all text and images from a PDF:**
1. Do one of the following:
   - Click the Nitro PDF Button, click the Export slideout, and then click Text & Images.
2. Choose your output settings, and then click Convert.

**To extract all text and images from a batch of PDF files:**
1. On the Home tab, in the Export group, click the arrow beneath Text & Images and then click Convert Multiple Documents.
2. Choose your output settings, and then click Convert.

6. Combining files & assembling pages

One of the main reasons why PDF documents have become so popular around the world is because they’re a great way to package up a collection of different files and to share them accurately and reliably. With Nitro PDF Professional, you can combine together reports, spreadsheets, presentations, and more in the one task.

- **Combine files to PDF**

In addition, Nitro PDF Professional gives you the complete set of tools for assembling and rearranging pages in PDF files, including:

- Crop or resize pages
- Rotate pages
- Extract pages
- Delete pages
- Reorder, move, or rearrange pages
- Insert pages
- Split pages
6.1 Combining files to PDF

Nitro PDF Professional allows you to convert and combine files together in the one task for files supported by one-click creation.

**Supported file types**

<table>
<thead>
<tr>
<th>Documents</th>
<th>Graphics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Word (.DOC, .DOCX)</td>
<td>Bitmap (.BMP)</td>
</tr>
<tr>
<td>Microsoft Excel (.XLS, .XLSX)</td>
<td>GIF (.GIF)</td>
</tr>
<tr>
<td>Microsoft PowerPoint (.PPT, PPTX)</td>
<td>JPEG (.JPG, .JPEG, .JPE)</td>
</tr>
<tr>
<td>Microsoft Publisher (.PUB)</td>
<td>JPEG2000 (.JPF, .JP2, .J2K)</td>
</tr>
<tr>
<td>Microsoft Visio (.VSD)</td>
<td>PNG (.PNG)</td>
</tr>
<tr>
<td>Nitro PDF (.PDF)</td>
<td>Metafile (.WMF, .EMF)</td>
</tr>
<tr>
<td>HTML (.HTML, .HTM)</td>
<td>TIFF (.TIF, .TIFF)</td>
</tr>
<tr>
<td>WordPerfect (.WPD)</td>
<td></td>
</tr>
<tr>
<td>Rich Text (RTF)</td>
<td></td>
</tr>
<tr>
<td>Text (.TXT)</td>
<td></td>
</tr>
<tr>
<td>Bitmap (.BMP)</td>
<td></td>
</tr>
<tr>
<td>GIF (.GIF)</td>
<td></td>
</tr>
<tr>
<td>JPEG (.JPG, .JPEG, .JPE)</td>
<td></td>
</tr>
<tr>
<td>JPEG2000 (.JPF, .JP2, .J2K)</td>
<td></td>
</tr>
<tr>
<td>PNG (.PNG)</td>
<td></td>
</tr>
<tr>
<td>Metafile (.WMF, .EMF)</td>
<td></td>
</tr>
<tr>
<td>TIFF (.TIF, .TIFF)</td>
<td></td>
</tr>
</tbody>
</table>

To combine files to PDF from a folder or the desktop:
1. Open the folder that contains the files you want to combine.
2. Hold down CTRL and left-click the files you want to select.
3. Right-click, and then click **Combine files in Nitro PDF**.
4. Click **Move Up** and **Move Down** to put the file in the order in which they should be combined.
5. In the **Make PDF files** list do one of the following, depending on whether file size or print quality is more important to you:
   - If the document requires high print quality, click **Print-ready**.
   - If the print quality is less important than file size, click **Office-ready**.
   - If a small file size is the most important quality, click **Web-ready**.
6. In the **Save PDF to** list, select the location you want to save the file to.
7. Click **Create**.

To combine files to PDF in Nitro PDF Professional:
1. On the **Home** tab, in the **Convert** group, click **Combine Files**.
2. On the **Combine PDF** dialog, click the **Add Files** button, and then select and order the files to convert.
3. In the **Make PDF files** list do one of the following, depending on whether file size or print quality is more important to you:
   - If the document requires high print quality, click **Print-ready**.
   - If the print quality is less important than file size, click **Office-ready**.
   - If a small file size is the most important quality, click **Web-ready**.
4. In the **Save PDF to** list, select the location you want to save the file to.
5. Click **Create**.

6.2 Assembling pages

The Pages pane that can display along the left of the Nitro PDF Professional window can make rearranging the pages of your PDF documents much easier. The Pages pane displays thumbnail size versions of each page so you can quickly identify and select the pages you want to edit.
To access the page assembly tools, do one of the following:
- On the Insert and Edit tab, go to the Pages group.
- On the Home tab, in the Show/Hide group, click Pages, and then right-click in the Pages pane.

To show the Pages pane:
- On the Home tab, in the Show/Hide group, click Pages.

6.3 Cropping or resizing pages

The Crop tool enables you to change the size of one or more pages in your PDF documents. You can crop pages visually with the Crop tool, or by adjusting the margins in the Crop Pages dialog.

To crop pages with the Crop tool:
1. On the Insert and Edit tab, in the Pages group, click Crop.
2. On the page to crop, left-click and drag the cursor to select the crop area.
3. Double-click on the crop area.
4. In the Crop Pages dialog, adjust the crop margins and select the pages to crop.
5. Click Crop.

6.4 Rotating pages

Being able to rotate pages is often required when pages in portrait mode and landscape mode are mixed together in the one document as having both portrait and landscape pages can make it more difficult to read. For example, a PDF document may have content suited to landscape view mode, like tables and photos, and also contain text-heavy documents well suited to portrait mode. With Nitro PDF Professional you can rotate any page in 90° increments.

With Nitro PDF Professional you can rotate pages in two ways:
- Rotate while viewing. Allows you to temporarily rotate all pages in the PDF you are currently viewing.
- Rotate permanently. Allows you to change the rotation of one of more pages in a document and to save those changes.

To temporarily rotate a PDF document while viewing it:
1. On the View tab, in the Rotate group, click Left or Right.

Note: The rotation you make here is not saved when you close the document.

To permanently rotate pages in a PDF:
1. On the Insert and Edit tab, in the Pages group, click Rotate.
2. In the Direction list, click the rotation level.
3. Click or specify the pages to rotate.
4. Click Rotate.

6.5 Extracting pages

Nitro PDF Professional lets you copy one or more pages from a PDF document to quickly create a new document. You can also delete the pages when extracting them.
To extract pages do the following:
1. On the Insert and Edit tab, in the Pages group, click Extract.
2. In the Extract Pages dialog, select the pages to extract.
3. Click Extract.

6.6 Deleting pages

Nitro PDF Professional lets you easily delete pages from your PDF documents, which means there’s no need to go back to the source document. You can do this via the Pages pane or the Insert and Edit tab.

To delete pages from a PDF:
1. On the Insert and Edit tab, in the Pages group, click Delete.
2. In the Delete Pages dialog, select the pages to extract.
3. Click Delete.

To extract pages with the Pages pane:
1. On the Home tab, in the Show/Hide group, click Pages.
2. In the Pages pane, hold down CTRL and left-click pages or left-click and drag to select pages.
3. Click Delete.
4. To confirm the delete, click OK.

6.7 Reordering & rearranging pages

If you’ve combined a collection of files together (e.g. a report, spreadsheet, and presentation) into a PDF document and they’re in the wrong order, you can easily rearrange them using the tools in Nitro PDF.

Using the Pages pane it’s just a matter of viewing the thumbnail versions of the pages of your document and dragging the pages around till they’re in the right order.

To reorder pages in the Pages pane do the following:
1. On the Home tab, in the Show/Hide group, click Pages.
2. In the Pages pane, do any of the following:
   - To select one page to move, left-click on it.
   - To select multiple pages that are not in sequence, press CTRL and left-click each page.
   - To select consecutive pages, left-click and drag the pointer.
3. Left-click on the selection and drag the page/s to the new position in the document.

6.8 Inserting pages

Nitro PDF Professional let you combine pages from more than one PDF together into the one PDF. When you insert pages you can choose whether to insert all the pages of a document or just a page range from the document.

To insert pages into a PDF:
1. On the Insert and Edit tab, in the Pages group, click Insert.
2. In the Open dialog, select the document to insert.
3. Click **Open**.
4. In the **Insert Pages** dialog, click the options to set the page range to be inserted, and where to place it in your PDF file.
5. Click **Insert**.

### 6.9 Splitting pages

The page splitting functionality gives you advanced tools to copy pages from existing PDFs and re-use them to assemble new files. The functionality includes:

- Splitting into groups of pages
- Splitting based on bookmarks
- Splitting based on the page range parameters you specify

#### Retaining navigation when splitting

A common problem when splitting PDF files is that most of the connections between the links and their end points are broken because they are no longer located in the same PDF file or because the pages have been rearranged. The advanced update navigational elements feature updates all links in bookmarks, links and destinations, ensuring all links are correctly maintained.

### 6.9.1 Split into groups of pages

Split PDF files into a set of PDFs with each containing a specific number of pages. For example, choosing to split a 30-page file into 5-page files would produce 6 PDF files.

**To split a PDF into groups of pages:**

1. On the **Insert and Edit** ribbon tab, in the **Pages** group, click **Split Pages**.
2. Click the **Into files of n pages** option, and then enter the number of pages each new file should contain.
3. Click **Split**.

### 6.9.2 Split by bookmarks

Use the bookmark hierarchy and bookmark levels to determine how to split your PDF files. This can be particularly useful when bookmarks are based on the sections and structure of your PDFs. When splitting, Nitro PDF Professional uses the bookmark text to form the file names of the resulting PDFs.

**To split by bookmarks:**

1. On the **Insert and Edit** ribbon tab, in the **Pages** group, click **Split Pages**.
2. Click the **By bookmarks** splitting method, and enter the level or levels of bookmarks to split at.
3. Click **Split**.

### 6.9.3 Split by page ranges

The page range method gives you additional page splitting flexibility, including:

- Splitting individual pages into new file(s).
- Splitting a page range into new file(s).
- Combine pages and page ranges.
- Separating page ranges into separate output files.
- Extracting unwanted pages.
• Using overlapping page ranges to create multiple files.
• Split into odd and even pages.
• Reverse page order.

By combining page numbers with simple parameters (commas, dashes, semicolons, odd, and even), you can specify which pages should be merged together to form a new PDF, and which pages should be split separately to form another PDF.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>’</td>
<td>page separator</td>
<td>1-20, 30-40 would create a single PDF containing page 1-20 and 30-40.</td>
</tr>
<tr>
<td>-</td>
<td>from/to</td>
<td>1-5 would extract pages 1 through 5 into a new PDF. 5-1 would extract pages 5 through 1 into a new PDF (reverse order).</td>
</tr>
<tr>
<td>;</td>
<td>file separator</td>
<td>1-20; 21-40 would create two new PDFs - one containing pages 1-20, the other containing pages 21-40.</td>
</tr>
<tr>
<td>even</td>
<td>even page</td>
<td>1-20 even would create a single PDF containing only the even pages within the range of 1-20.</td>
</tr>
<tr>
<td>odd</td>
<td>odd page</td>
<td>1-20 odd would create a single PDF containing only the odd pages within the range of 1-20.</td>
</tr>
</tbody>
</table>

To split by page range:
1. On the Insert and Edit ribbon tab, in the Pages group, click Split Pages.
2. Click the Into files of n pages option, and then enter the page range to use.
3. Click Split.

7. Editing

With proper PDF editing tools the amount of time you spend switching between different programs and file types is minimized. Nitro PDF Professional includes an extensive set of tools to fix the text, graphics and pages in your existing PDFs, as well as prepare and polish them for distribution.

<table>
<thead>
<tr>
<th>Text</th>
<th>Images</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Delete</td>
<td>Document Info</td>
</tr>
<tr>
<td>Headers &amp; footers</td>
<td>Insert</td>
<td>Initial View</td>
</tr>
<tr>
<td>Bates numbering</td>
<td>Replace</td>
<td>Fonts</td>
</tr>
<tr>
<td></td>
<td>Crop</td>
<td>Security</td>
</tr>
<tr>
<td></td>
<td>Extract</td>
<td>Optimize &amp; shrink</td>
</tr>
<tr>
<td></td>
<td>Resize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrange</td>
<td></td>
</tr>
</tbody>
</table>
7.1 Undo/redo edits

The new Nitro PDF Professional interface does not have the traditional Edit menu that contains the undo/redo functionality. Never fear, it’s still close at hand.

**How to undo/redo changes:**
1. Do one of the following:
   - Press CTRL+Z to undo, or CTRL+SHIFT+Z to redo.
   - In the Quick Access Ribbon, in the top-left corner of the Nitro Pro window, click **Undo** or **Redo**.

7.2 Text

Nitro PDF Professional includes all the text-editing tools usually required for making last-minute corrections and updates to PDF documents, without the need to go back to the source files in Word, Excel, WordPerfect and so on.

- **Headers & footers**
- **Bates numbering**

The **Edit Text & Images** tool is perfect for quickly fixing ‘typos’ and making minor formatting changes to text, as well moving, editing and deleting text and images in your PDF.

**Tip:** If you’re planning to make many small or several major text corrections to a document, we recommend you go back to the source file and make the changes there—you’ll have more precise control over the exact layout and look, and there may be an opportunity to automate the corrections to save time.

**Edit Different Fonts**

The properties of fonts can vary significantly depending on the settings used during the PDF file’s creation, and this can affect your ability to edit text at all in a PDF. In particular, PDF files containing subset fonts can be problematic when last minute edits are required.

- **Non embedded.** These create the smallest file size because no fonts are embedded within the PDF. The tradeoff is that the PDF will most likely look different for different users. If you use common system fonts like Times New Roman, Arial, Times, Courier, and Symbol then you file will look pretty similar but if you use a font that your recipients do not have installed, then your document could look quite different to the file you designed.
- **Subset embedding.** These embed just the characters from each font that appears in the source file. This means that only part of the whole font has been included and that if you try to type a character (e.g. X) that was not used in the document when it was created, it cannot be inserted into the document. The reason why people subset embed fonts is that they want their file to look exactly as they designed but they want it to be as compact as possible -- embedding a whole font can increase
the size significantly.

Note: If you try to enter a character that was not included in a subset font, the character will appear as a rectangle.

- **Full embedding.** These create the largest file size PDF files but are the easiest to edit text in.

Tip: To see the full properties of text, select the Edit Text & Images tool, right click on text and click Properties.

**To insert text:**

1. On the *Insert and Edit* tab, in the *Text* group, click *Insert*.
2. Click on page where you would like to insert text.
3. On the *Insert and Edit* tab, in the *Text* group, click any of the text options to set the appearance of the text.

**To edit text:**

1. On any ribbon tab, in the *Tools* group, click the arrow beneath *Copy Text*.
2. Click *Edit Text & Images*.
3. Double-click on the text you want to edit.

Note: If you don’t have the font installed that you are trying to edit, and it has not been embedded, you may not be able to edit the text. It’s important to understand that if you are working on a PDF document and you want to correct or modify the text it contains, it’s essential you either have the font installed on your computer or have it embedded in the document. Some fonts will work fine because everyone will have them installed. If you are unsure about the fonts other users have and you want them to be able to modify the text, it’s best to stay with system fonts like Times New Roman, Arial, Times, Courier, and Symbol.

**To view all text properties:**

1. On any ribbon tab, in the *Tools* group, click the arrow beneath *Copy Text*.
2. Click *Edit Text & Images*.
3. Double-click on the text.
4. Right-click and then click *Properties*.

**7.2.1 Adding headers & footers**

The headers & footers tool lets you quickly insert text and graphics across one or more pages in a document, and place this new content in front of or behind existing page content. Best of all, by saving your settings as profiles, you can reuse them over and over. Here’s some examples of how you might like to use the headers and footers functionality:

- **Dynamic stamps.** Automatically insert dynamic information like page numbers, author, document title, date and time.
- **Headers.** Insert document title, chapters and date information.
- **Footers.** Insert page numbering, date, and time information.

**To insert a header and footer:**
1. On the **Insert and Edit** tab, in the **Header & Footer** group, click the **Header & Footer** text label.
2. In the **Apply** to document list, click the profile to use.

Note: If you are inserting text-based headers or footer, they may not display the same way if the recipient doesn’t have them installed on their system. If you are unsure about what fonts your recipients use, it’s best to use system fonts like Times New Roman, Times, Courier, Helvetica and Symbol.

### To create a header & footer profile:

1. On the **Insert and Edit** tab, in the **Header & Footer** group, click **Header & Footer**.
2. Click **New Profile**.
3. Click **Add**, and then click the type of header or footer to add.
4. In the **Header/Footer** name box, enter a name.
5. Click the options to set the look and placement of the header or footer.
6. Click **Save**.

### To create a header & footer profile with dynamic text:

1. On the **Insert and Edit** tab, in the **Header & Footer** group, click **Header & Footer**.
2. Click **New Profile**.
3. Click **Add**, and then click **Text**.
4. In the **Header/Footer** name box, enter a name.
5. In the **Dynamic text** list, click the option you want to use.
6. Click **Insert**.
7. Click the other options to set the look and placement of the dynamic text.
8. Click **Save**.

#### 7.2.2 Adding Bates numbering

Bates numbering is useful in legal and other fields that need all pages in a document collection to be labeled, accounted for, and easy to locate. The Bates numbering tool allows you to add a unique number to each page. You can start the numbering at any point and, when processing more than one document, continue the numbering across the documents.

### To add Bates numbers to a PDF:

1. On the **Insert and Edit** tab, in the **Header & Footer** group, click **Bates Number**.
2. In the **Prefix**, **Suffix**, and **Start at** boxes, enter your numbering as required.
3. Click the options to use for font properties and layout, and the pages to process.
4. Click **Apply**.

### To add Bates numbers to a collection of PDF files:

1. On the **Insert and Edit** tab, in the **Header & Footer** group, click the arrow below **Bates Number** and click **Multiple Files**.
2. Add and order the files you want to process, and then click **Next**.
3. In the **Prefix**, **Suffix**, and **Start at** boxes, enter your numbering as required.
4. Click the options to use for font properties and layout, and the pages to process.
5. Click **Apply**.
7.3 Images

Nitro PDF Professional includes an advanced set of tools for editing images directly, meaning there should be less need to go back to the source document when fixes are required.

Images can be edited by selecting them with the Edit Text & Images tool. When you double-click an image a new Format tab will appear in the ribbon area that is home to all image editing tools.

- Delete
- Insert
- Replace
- Crop
- Extract
- Resize
- Arrange
- Color space
- Watermarks

7.3.1 Arranging images

The image arranging tools let you move images in front and behind other objects on the page, flip or mirror, and rotate them.

To rearrange images:
1. On any ribbon tab, in the Tools group, click the arrow beneath Copy Text.
2. Click Edit Text & Images.
3. Double-click the image.
4. On the Format context tab, in the Arrange group, click Bring To Front, Send To Back, Flip, or Rotate.

7.3.2 Resizing and cropping images

The image editing tools let you resize an image proportionally, or you can adjust just the height or width. If you want to permanently remove detail from the edges of images then you can use the crop tool.

To resize images:
1. On any ribbon tab, in the Tools group, click the arrow beneath Copy Text.
2. Click Edit Text & Images.
3. Click the image.
4. Do one of the following:
   - To resize proportionally, grab and drag the corner of the image.
   - To resize the height or width, grab the image at the mid-point between the corners and drag the image.

To crop an image:
1. On any ribbon tab, in the Tools group, click the arrow beneath Copy Text.
2. Click Edit Text & Images.
3. Double-click the image.
4. On the **Format** context tab, in the **Size** group, click **Crop**.
5. To crop the image, grab the edge of it and drag towards the center of the image.

### 7.3.3 Replacing images

The Replace Image functionality lets you remove one image and put another in its place. Once inserted, you can use the full set of image editing tools to correctly position and size the new image.

**To replace an image:**

1. On any ribbon tab, in the **Tools** group, click the arrow beneath **Copy Text**.
2. Click **Edit Text & Images**.
3. Do one of the following:
   - Double-click the image.
   - Click the images, and then click the **Format** context tab in the ribbon.
4. On the **Format** context tab, in the **Adjust** group, click **Replace**.
5. Select the new image and then click **Open**.

### 7.3.4 Extracting images

The Extract Image tool lets you extract images out of PDFs for reuse in other applications.

**To extract an image:**

1. On any ribbon tab, in the **Tools** group, click the arrow beneath **Copy Text**.
2. Click **Edit Text & Images**.
3. Do one of the following:
   - Double-click the image.
   - Click the images, and then click the **Format** context tab in the ribbon.
4. On the **Format** context tab, in the **Adjust** group, click **Extract**.
5. Save the image.

### 7.3.5 Inserting images

The Insert Image tool lets you add images to your PDF files so you don’t need to go back and edit the original source file.

**To insert images:**

1. On the **Insert and Edit** tab, in the **Graphics** group, click **Image**.
2. Select the image and click **Open**.
3. Click the image and then resize and move it to the correct position on the page.

### 7.3.6 Changing image color space

With Nitro PDF Professional, you can update the color space of each image individually.

**To change the color space of images:**

1. On any ribbon tab, in the **Tools** group, click the arrow beneath **Copy Text**.
2. Click **Edit Text & Images**.
3. Double-click the image.

4. On the **Format** context tab, in the **Adjust** group, click **Color**.
5. Click the color space.

### 7.3.7 Deleting images

You can use the Edit Text & Images tool to remove images from your PDF files.

**To delete images:**

1. On any ribbon tab, in the **Tools** group, click the arrow beneath **Copy Text**.
2. Click **Edit Text & Images**.
3. Click the image to delete.
4. Do one of the following:
   - Press the **Delete** key.
   - Right-click and then click **Delete**.

**To select multiple images:**

1. On any ribbon tab, in the **Tools** group, click the arrow beneath **Copy Text**.
2. Click **Edit Text & Images**.
3. Do one of the following:
   - Hold down the **SHFT** key and then click on each image to select.
   - Click and drag the pointer to select a group of images.
4. Do one of the following:
   - Press the **Delete** key.
   - Right-click and then click **Delete**.

### 7.3.8 Watermarks

The watermarks tool lets you can quickly insert text and graphics across one or more pages in a document. You have full control over the position, size, opacity, and more of your watermarks, and you can save them for reuse. Common uses of watermarks include:

- **Backgrounds and watermarks.** Insert company logos and other marks to retain corporate identity across pages and documents.
- **Showing document status.** Apply an image as a watermark—such as Reviewed, Approved, and Draft—so your recipients know the status of the document you have shared.

**To create a watermark profile:**

1. On the **Insert and Edit** tab, in the **Graphics** group, click **Watermark**.
2. Click **New Profile**.
3. Click **Add**, and then click the type of header or footer to add.
4. In the **Watermark** name box, enter a name.
5. Click the options to set the look and placement of the watermark.
6. Click **Save**.

**To insert a watermark:**

1. On the **Insert and Edit** tab, in the **Graphics** group, click the **Watermark** text label.
2. In the **Apply to document list**, click the profile to use.

**Note:** If you are inserting text-based watermarks, it may not display the same if the recipient doesn’t have them installed on their system. If you are unsure about what fonts your recipients use, it’s best to use system fonts like Times New Roman, Times, Courier, Helvetica and Symbol.

### 7.4 Optimizing & shrinking files

Nitro PDF Professional includes a powerful set of tools for removing unwanted document objects and compressing images – helping you shrink files significantly.

- **Document objects.** These general settings allow you to remove individual types of objects, including annotations, form fields, JavaScript, links, bookmarks, attachments, named destinations, embedded thumbnails, invalid or unused links, and bookmarks and name destinations.
- **Image compression.** These image compression feature gives you a simple slider tool to apply more or less compression. The higher the percentage, the higher the compression.

**To optimize a PDF file:**
1. Click the [Nitro PDF Button](#), point to the arrow next to *Prepare*, and then click *Optimize Document*.
2. Click the options you would like to remove or optimize.
3. Click *OK*.

### 7.5 Attaching files

PDF documents can not only contain text and graphics, they can contain entire files inside them — making exchanging sets of documents much easier and more reliable. For example, if you’re sending a PDF document for review, you could attach the source file (like a Microsoft Word file) inside the PDF document.

Nitro PDF Professional let’s you attach files at the document level or attach them to pages as an annotation. The Attachments pane gives you a central place to view, insert, delete, and export attachments.

**To view, edit, open, and save all file attachments in a file:**
- On the *Home* tab, in the *Show/Hide* group, click *Attachments*.

**To attach a file to a PDF:**
- On the *Insert and Edit* tab, in the *Files* group, click *Attach*.

### 7.6 Document properties

The document information fields in Nitro PDF Professional are useful for users who want to know more about a document, and they’re particularly useful if documents are to be indexed. These fields can be used to help categorize documents and help narrow down search results from search engines and other indexes.

**To view document properties:**
- Click the [Nitro PDF Button](#), and then click *Document Properties*. 

© 2008 Nitro PDF Software
7.6.1 **Document information or metadata**

With Nitro PDF Professional you can edit the document title, author, subject, and keyword fields, as well as add your own custom metadata fields.

Tip: Not all the document information can be modified. Many fields are set at the time of creation or when last edited. For example, creation time, creator, optimization, PDF version, and so on.

**To add or edit document information or metadata:**

1. Click the **Nitro PDF Button**, and then click **Document Properties**.
2. In the **Title**, **Author**, **Subject** and **Keywords** boxes, update or enter text.
3. Click **OK**.

**To add or edit custom metadata fields:**

1. Click the **Nitro PDF Button**, and then click **Document Properties**.
2. Click **Edit**.
3. In the **Name** and **Value** boxes, enter your text, and then click **Add**.
4. Click **OK**.
5. In the **Document Properties** dialog, click **OK**.

7.6.2 **Initial View properties**

PDF documents can be set to display in particular ways when opened in a PDF viewer. For example, if your document contains bookmarks and you want them to be easily accessible, you can set the document to open with the Bookmarks pane already displayed. You can also set your PDF so it’s displayed at a particular zoom level, opens at a particular page, and so on. In Nitro PDF Professional these settings are all controlled in the Document Properties dialog.

- **Navigation.** Sets which pane is displayed by default. The Bookmarks pane, Pages pane, or no pane.
- **Always open document to page.** Specifies which page to open the PDF at.
- **Page layout.** Sets the page mode to open with, Single, Continuous, Facing, or Facing Continuous.
- **Zoom.** Sets default magnification level. Choose from zoom percentage, or choose from the Fit Page, Fit Width and Fit Height settings.
- **Set window title.** Set what is displayed in the title bar of Nitro PDF Professional. Either the file name or the document title field.
- **Hide menu bar.** Stops the menus from appearing when a PDF is opened in Adobe Reader or Acrobat.
- **Hide tools.** Stops the toolbars from appearing when a PDF is opened in Adobe Reader or Acrobat.
- **Hide window controls.** Stops the left pane and status bar from appearing when a PDF is opened in Adobe Reader or Acrobat.
- **Resize window to fit document.** Resizes the size of the Nitro PDF Professional window to fit the magnification size specified for the document to display at.
- **Center window on screen.** Opens the Nitro PDF Professional application window in the center of your screen.
- **Full-screen mode.** Opens the document in full-screen mode when opened in Adobe Reader or Acrobat.

**To set initial view properties:**

1. Click the **Nitro PDF Button**, click **Document Properties**, and then click the **Initial View** tab.
2. Click the options you would like to use.
3. Click **OK**.
4. In the **Document Properties** dialog, click **OK**.

### 7.6.3 Fonts

If you need information on the fonts contained in a document, you can do this in the Document Properties dialog. To edit text, see the [Text Editing](#) section.

**To view all fonts in a document:**
- Click the **Nitro PDF Button**, click **Document Properties**, and then click the **Fonts** tab.

### 7.6.4 Document security

Details on the security and restrictions that have been placed on a PDF can be found in the Document Properties dialog. (For in-depth information, see the [Security](#) section of the user guide.)

**To view the security in a file:**
1. Click the **Nitro PDF Button**, and then click **Document Properties**.
2. Click the **Security** tab.

### 8. Interactivity

Nothing makes your PDF documents usable more quickly than bookmarks and links. By using them you can make it much easier to navigate to pages, open other files and access pages on the web.

- **Bookmarks**
- **Links**

**Tip:** To quickly make your document easier to navigate, use the tools for automated bookmark and link creation.

### 8.1 Bookmarks

The bookmarks in Nitro PDF Professional work much like the bookmarks you place in paper books—they allow you to retain links to particular pages in a document for quicker access, as well other actions, such as:
- Go to a page in a document.
- Go to a page in another PDF document.
- Go to a web page.
- Open another file.
- Reset a form.
- Submit a form.
- Run JavaScript.

With electronic bookmarks you can group them together in hierarchies, specify the exact text labels to use, and set your document so that the bookmarks are displayed or hidden when a document is first opened.

If they're well laid out, a set of bookmarks will help the user understand the basic structure of long documents. Moreover, including bookmarks like this will hopefully encourage users of your documents to
read them online instead of wasting paper by printing them.

The most common use of bookmarks—linking to different pages within a PDF—is just about the simplest way to make a document more user friendly.

**To view bookmarks in a PDF file:**
- On the Home tab, in the Show/Hide group, click Bookmark.

Tip: You can set the initial view of a document so that it opens with the Bookmarks pane already displayed. Go to Nitro PDF Button > Document Properties > Initial View and choose the Bookmarks pane and pages option.

8.1.1 **Viewing and using bookmarks**

Bookmarks are displayed in the Bookmarks pane, which appears to the left of the document area.

**To open the Bookmarks pane:**
- On the Home tab, in the Show/Hide group, click Bookmark.

**To increase or decrease the font size displayed in the Bookmarks pane:**
1. Click the Nitro PDF Button, and then click Nitro PDF Preferences.
2. Click Interface, and in the Bookmark text size list, click the text size.
3. Click OK.

8.1.2 **Creating bookmarks**

You can create bookmarks by selecting text on a page and making it a bookmark, or by adding an untitled bookmark and then setting and naming it in the Bookmarks pane.

When adding bookmarks that link to another part of the same document, you’re not limited to just linking to a page number, you can have precise control over the exact view a user experiences—for example, a bookmark could move a user to another page and zoom in to a small area of the page. You set this by editing the action property of the bookmark.

**To add a bookmark to a PDF document:**
2. In the Bookmarks pane, type in your bookmark label.

Note: A bookmark added this way is set by default to link to the current page being viewed. To use a different kind of action, see the editing bookmarks section below.

**To turn a heading or text into a bookmark:**
1. On the ribbon tab, in the Tools group, click Copy Text.
2. Highlight the text to use.
3. Right-click and then click Add Bookmark.
4. In the Bookmarks pane, drag the bookmark to its correct position amongst the existing bookmarks.
8.1.3 Editing bookmarks

Nitro PDF Professional comes with a complete set of tools for editing, ordering, grouping, altering the appearance of, and deleting the bookmarks in your PDF documents.

Tip: You can edit more than one bookmark at a time. To select a range of bookmarks already in order, left-click the first one, then hold down Shift and click the last one. To select bookmarks that are not next to each other, just hold down Control while you select them.

To set the bookmark action:
1. In the Bookmarks pane, right-click on the bookmark and select Properties.
2. Click the Action tab.
3. In the Action list, click the action, and then click Add Action to List.
4. Set the action.
5. Click Close.

To delete a bookmark:
1. In the Bookmarks pane, select the bookmark and do one of the following:
   • Press the Delete key.
   • Right-click and click Delete.

To delete all bookmarks:
1. On the Insert and Edit tab, in the Navigation group, click the arrow below Bookmark.
2. Click Delete All Bookmarks.

To rename a bookmark label:
1. In the Bookmarks pane, do either of the following:
   • Right-click and choose Rename.
   • Double-click the bookmark label.
2. Type the new bookmark text.

To change the appearance of bookmarks:
1. Right-click on the bookmark(s) and do any of the following:
   • In the Style list, click the text style.
   • In the Color palette, choose a pre-defined or custom color.

Bookmarks can be nested or grouped together so that a parent bookmark has child bookmarks grouped under it—this allows you to have multiple tiers or levels of bookmarks, which become particularly useful when preparing navigation for long, well-structured documents.

To reorder bookmarks:
1. Click the bookmark and drag it to the new position.
2. Place the cursor on top of the bookmark that will appear above it and release the bookmark.

To group or nest bookmarks:
1. Click the bookmark and drag it to the new position.
2. Place the cursor on top of the bookmark text label that will appear above it and release the bookmark.
8.1.4 **Automatic bookmark creation**

The Auto Build Bookmarks feature can totally automate the creation of bookmarks in your PDFs, and with very little effort greatly enhance the usability of the PDFs you publish. Use it to auto-generate bookmarks based on the font styles (headings, chapters, etc.) and the layout used in your PDFs. You can also use it to build bookmarks based on the textual and numerical content of the PDF files by using the text masking and wildcards features.

**To create bookmarks automatically:**

1. On the **Insert and Edit** tab, in the **Navigation** group, click the arrow below **Bookmark**.  
2. Click **Auto Build Bookmarks**.  
3. In the **Build Bookmarks** dialog, click **Level 1**. This will open up the **Select Bookmark Attributes** dialog.  
4. Do one or both of the following:  
   • With the mouse pointer use the cursor to select an example of the text (such as a heading) on the page.  
   • Enable the checkboxes of the properties that you want to create the bookmarks from.  
5. Click **OK**.  
6. To make more than one tier of bookmarks, click **Level 2** (and so on) and then perform steps three and four again.  
7. In the **Build Bookmarks** dialog, click **Build**.

**Tip:** With Nitro PDF you can generate bookmarks automatically from your Word and PowerPoint based on the heading styles they contain. See the Create PDF section of the user guide.

**Bookmark selection attributes**

There are five text properties that can be used when choosing the properties that the bookmarks will be created from. Combining the various properties will create bookmarks that only match the criteria of the combined properties. If the text in the document does not meet the requirements of the properties, then no bookmarks will be created.

- **Font Name.** Creates bookmarks from the selected font. Clicking Update Font Name will update the font menu listing to include all the fonts contained in the document. Embedded fonts are not included.
- **Font Size.** Creates bookmarks from text that conforms to the specified font size.  
- **Font Color.** Creates bookmarks from text that matches the selected text’s color.  
- **Left Indentation.** Creates bookmarks from text with its line indent starting at the specified distance from the left-hand side of the page. An example of line indentation is bullet headings—selecting these bullet headings with the Left Indentation and Font Name properties enabled would produce bookmarks from the bullet headings: Font Name, Font Size, Font Color, Left Indentation and Text Mask (if the Font Name property wasn’t enabled, all text with the same indentation as the bullets would be turned into a bookmark).  
- **Text Mask.** Creates bookmarks from text that matches the characters entered into the Text Mask textbox. Text masking is handy when there are no defining bookmark properties, or if you need to selectively filter out certain text that may otherwise become a bookmark. See the section on text masking for more information on using these special characters.  
- **Keyword list.** This feature allows you to include and exclude particular bookmarks based on its text label. The keyword list file is simply a text file with a list of words. If you choose to include with a keyword list, then the only bookmarks generated will be ones that include any of the keywords in your list. If you choose to exclude with a keyword list, then no bookmarks will be created that contain any of the words in your keywords list.  
- **Ignore repeated headings.** Creates a bookmark for only the first occurrence of a repeated...
bookmark name.

- **Multi-lined headings.** Creates bookmarks from text spanning more than one line.

- **Leading numbers.** This feature allows you to add or remove leading numbers to bookmarks. For example, if your headings and chapters are prefixed with a numbering system. These leading numbers can be excluded from the bookmark labels that are generated automatically.

- **Text masking.** Includes or excludes content as bookmarks based on the wildcards you specify. Instead of searching a PDF file for the attributes (font name, size and color) and layout (indentation) the Text Mask feature allows you to search the text content of the files to include and exclude text from being made into a bookmark. Text masking is particularly useful when there are few defining bookmark properties—when the PDF file has not been structured well or consistently—or when you want to filter out bookmarks based on their text-based content.

### Text Masking

Text Masking gives you more advanced tools that let you include or exclude content as bookmarks based on the wildcards you specify. Text masking is particularly useful when there are few defining bookmark properties—when the PDF file has not been structured well or formatted consistently—or when you want to filter out bookmarks based on their text-based content.

- The "." matches one instance of any character.

  **Example:** Entering the expression "P.F" into the Text Mask field would create a bookmark from any line of text that contained "PDF, PeF, PdF," etc.

- The "^" only creates a bookmark if the specified text appears at the very start of the line.

  **Example:** Entering the text "\(^abc\)" will only create a bookmark if the line started with "abc". If a line of text started with "1.0 abc" no bookmark would be created.

- The "$" only creates a bookmark if the specified text appears at the very end of the line. If you only want to create bookmarks from lines that only contain the exact text you specify, use both the "^" and "$" characters.

  **Example:** Entering the text "abc$" will create a bookmark only from text with lines ending with "abc", so "...xyzabc" would generate a bookmark from that line, but "abcxyz" would not.

- Any lines containing characters inside the ":[ ]" will generate a bookmark. Characters can be specified literally, or as a range of characters.

  **Example:** "[abc]" will create bookmarks from any lines containing either a, b, or c. This is
opposed to only creating a bookmark from text containing abc if “abc” is entered. “[a-zA-D]” will create bookmarks from lines containing any of the characters between a-d (that is, a, b, c and d), in both lower- and upper-case.

[^]
Any text containing characters inside the “[ ]” and after the “^” will not be turned into bookmarks. This feature is very handy when applied with in conjunction with other bookmark selection properties to stop unwanted bookmarks from being created. Please note that conversely this means that any other text not in the “[ ]” will be considered as potential bookmark material. Therefore you should consider using another bookmark selection in conjunction with this one. If you really want to exclude numbers like 1.0 you would need to modify it to “[^0-9\.].” The “\” is explained below, and is needed because “.” is a considered special character in text masking.

Example: Entering “[^0-9]” will still create bookmarks containing numbers if the text line contains any other character – 1.0 will be turned into a bookmark because it contains a “.”.

\n
The “\” character is used when you wish to actually match a special character, such as “.” Or “$”. These special characters are used in the Text Mask field to perform special text matching.

Example: Entering “\$” will search and create a bookmark from text on the document containing a “$”, ignoring the normal “$” text mask command.

*  

Use the “*” character to create bookmarks from more than one set of characters at the same time.

Example: Entering “a*b” will create bookmarks from any line of text containing either a and/or b.

+  

Use the “+” character to create bookmarks from a set of characters arrayed in a certain order. Bookmarks can be created from the first character(s) before the “+”, however, characters after the “+” can only be bookmarked if the characters before the “+” are also present.

Example: Entering “a+b” will create bookmarks from any line of text containing ab, aab, aaab, etc. Any text like ba, or cb, will be ignored.

?  

Like the “+” character, the “?” character creates bookmarks from a set of characters arrayed in a certain order, but in this case, bookmarks can be created from characters before the “?” only if the proceeding
characters are also present. The characters after the "?" can be used to create bookmarks, irrespective of whether characters before the “?” are present.

Example: Entering “a?b” will create bookmarks from any line of text containing ab, abb, or just b.

( )

Allows characters to be grouped together and be combined with other special characters.

Example: “(a*b)$$” will create bookmarks from lines of text containing either a and/or b, but only if these lines end with a or b.

| Creates bookmarks from either one set of characters or another.

Example: Entering “a | b” into the Text Mask field will create bookmarks from lines of text containing either a or b.

8.2 Links

Links in Nitro PDF Professional add a powerful interactive aid that makes reading, navigating, and using PDF documents much easier onscreen. The links are inserted on the pages of your PDF documents and, when clicked, can perform different actions, such as:

- Go to page in document.
- Go to page in another PDF document.
- Go to a Web page.
- Open another file.
- Reset a form.
- Submit a form.
- Run JavaScript.

Links work much like links do on the web—when you hover over them with your mouse the cursor changes to indicate the link is there. When you click the link, an action is performed. You can easily format links in your PDFs so they are invisible or visible, using a variety of styles.

8.2.1 Adding links

You can add links manually to your PDF pages by clicking the Link tool and drawing the outline of the link on the page. Once it's added you can edit its appearance and set action it should perform when clicked by the user.

To add a link to a PDF document:

1. On the Insert and Edit tab, in the Navigation group, click Link.
2. On the page, click and drag the pointer to add the link.
3. In the Set Link Action window, select the Link action and set the link appearance properties.
4. Click Next.
5. Click on the link to move and/or resize it.

8.2.2 Editing links

You can control what links look like, including what color they are when visible, as well as how the link will appear when clicked on. If you need to you can also lock your links so each link keeps its position and properties.

If you have created a set of links in a PDF and they need to be precisely laid out—for example, when you’ve added navigation links in the header or footer of a page—use the link aligning tools in the Edit Link tool context menu.

To edit the appearance of links in PDF documents:

1. On the ribbon, in the Tools group, click Edit Links.
2. Right-click on the link and click Properties.
3. On the Appearance tab, click the options you would like to change.

Tip: To edit the appearance of more than one link, hold down Ctrl and left-click each link to select them.

To set the default link style:

1. On the ribbon, in the Tools group, click Edit Links.
2. Right-click on a link that uses the style you would like to make the default, and then click Use Current Appearance as Default.

To align, resize, and reposition links:

If you have created a set of links in a PDF and they need to be precisely laid out—for example, when you’ve added navigation links in the header or footer of a page—use the link aligning tools.

1. On the ribbon, in the Tools group, click Edit Links from the list of tools.
2. Hold down Ctrl and click on each link you would like to reposition.
3. Right-click and choose from the Align, Center, Distribute, and Size options.

Note: To use the Align, Center, Distribute, and Size options you must select at least two links.

To lock and unlock the position and properties of links:

1. On the ribbon, in the Tools group, click Edit Links.
2. Right-click on the link and select Properties.
3. Click the Locked option.
4. Click Close.

To delete links:

1. On the ribbon, in the Tools group, click Edit Links.
2. Left-click on the link to select it.
3. Do either of the following:
   - Press the Delete key on your keyboard.
   - Right-click on the link, click Edit and then Delete.
8.2.3 Automatic page number links

The Create Page Links tool lets you automatically turn all numbers on an area of the page into active hyperlinks that will link each number to the corresponding page in the document. It's ideal for making sections of documents, like the table of contents and index, more intelligent and easier to use. It's simply a matter of selecting the part of the page or range of pages you want to scan, and then running the tool to turn them into active links.

To create page links:

1. On the Insert and Edit tab, in the Navigation group, click the arrow beneath Link.
2. Click Auto Page Links.
3. To specify the area of the page or page range to process, do either of the following:
   • To scan only an area of the page, click and drag the cursor to select it, and then specify the pages to scan
   • To scan the whole page, or a range of whole pages, select the Range option, and then enter the pages to include
4. Click the options to set the appearance of the links.
5. Click the Create button to generate the links.

8.2.4 Automatic keyword link creation

With Nitro PDF Professional you can turn every occurrence of a particular word or phrase into an active hyperlink. For example, you could make all occurrences of your company name in your document link through to your company web site. The Auto Keyword Link tool gives you the choice of going through each occurrence and approving them one at a time, or you can just convert all occurrences automatically in the one go.

Links can be set to execute a variety of actions such as open a URL or external file, go to a specific page or named destination, or even the next instance of the word in the document.

To create keyword links:

1. On the Insert and Edit tab, in the Navigation group, click the arrow beneath Link.
2. Click Auto PDF Links.
3. In the Find box, enter the word or phrase you want to turn into an active link.
4. In the Action type list, click the action to use and then specify the action to perform.
5. In the Link properties group, click the options to set the appearance of the links.
6. To create the links, do either of the following:
   • To convert all keywords to hyperlinks, click the Create All button
   • To review each instance of a keyword before applying the link, click Find Next and then click Create to turn it into a link.
7. Click Close.

8.2.5 Creating web links from URLs

The Create Weblinks tool scans your PDF for URLs and turns them into active webpage links.

To make weblinks active:

1. On the Insert and Edit tab, in the Navigation group, click the arrow below Link.
2. Click Create Weblinks.
3. Click the option to specify the range of pages to scan for links.
9. Commenting

One of the biggest advantages of working with PDF is having the ability to annotate electronically in the same ways you can with paper. With Nitro PDF Professional, comments can be added to pages as sticky notes, text highlighting, drawing markups, stamps, and file attachments.

Most types of comments include a pop-up note for you to add a text message to them. For example, if you’ve marked some text with the Highlight Text tool, just open its pop-up note and enter your feedback to explain why you’ve highlighted it. All commenting and drawing tools are accessible from the Review tab.

- Sticky notes
- Highlight, underline & cross-out text
- Lines, arrows, rectangles, ovals, polygons and clouds
- Stamps
- File attachments
- Organize and view comments

9.1 Adding sticky notes

Sticky notes are the quickest and easiest comments to add and work well because they stand out. Like the paper version, you place the note onto the page you would like to add a comment to and then enter your text feedback into it for others to read.

To add a sticky note to a PDF document:

1. On the Review tab, in the Comment group, click Sticky Note.
2. Click on the page where you want to place the sticky note.

To update the appearance or properties of a sticky note:

1. Right-click on the sticky note icon.
2. Click Properties.
3. Click the options you want to change.
4. Click OK.

Tip: You can change the default properties of your comments by right clicking on a note and choosing the Set Properties as Default option.

9.2 Adding Text Boxes

The Text Box tool places a text box on top of the page content and unlike the Sticky Note (which can be opened and closed) it is always visible. Text Boxes can blend into the page content, so if you don’t want them to be missed, it’s worth making sure the color of the text box is different to the content on the page.

Tip: When trying to edit the properties of a text box, you need to be aware that there are different states, and you can only open the Properties dialog from one state. When the cursor is flashing inside the text box, you must click outside of the text box and then right-click to bring up the menu that gives you access to the properties.
To add a Text Box comment:
1. On the **Review** tab, in the **Comment** group, click **Text Box**.
2. Click and drag to position and size the Text Box.
3. Enter your feedback to the box.

To update the appearance of a Text Box:
1. Right-click on the text box.
2. Click **Properties**.
3. Click the options you want to change.
4. Click **OK**.

To set the default appearance of a Text Box:
1. Click a Text Box that uses the correct appearance.
2. Right-click on it.
3. Click **Make Current Properties Default**.

To delete a Text Box:
1. Click on the Text Box.
2. Press the **Delete** key.

### Adding Call Outs

The Call Out tool is similar to the Text Box (it is always visible) but has an additional, useful property—it has an adjustable arrow connected to it. This is particularly handy when you need to point to a very specific thing on the page.

**Tip:** When trying to edit the properties of a call out, you need to be aware that there are different states, and you can only open the Properties dialog from one state. When the cursor is flashing inside the call out, you must click outside of the call out and then right-click to bring up the menu that gives you access to the properties.

To add a Call Out comment:
1. On the **Review** tab, in the **Comment** group, click arrow beneath the **Text Box** and click **Call Out**.
2. To place the Call Out, click on the page.
3. Enter your feedback to the box, and then do any of the following:
   - To move the Call Out box, highlight it and move it.
   - To resize, highlight it and drag the edges.
   - To move the arrow, click on its' point and drag.

To update the appearance of a Call Out:
1. Right-click on the Call Out.
2. Click **Properties**.
3. Click the options you want to change.
4. Click **OK**.

To set the default appearance of a Call Out:
1. Click a Call Out that uses the correct appearance.
2. Right-click on it.
3. Click **Make Current Properties Default**.

**To delete a Call Out:**
1. Click on the Call Out.
2. Press the **Delete** key.

### 9.4 Highlighting text

The text highlighting tools let you review copy electronically the same way you do on paper. The different pen-like tools let you highlight, underline and cross-out text, and then add text feedback to each one your markups.

Tip: The Underline Text tool's properties can be changed so that a squiggly line appears beneath highlighted text instead of a straight line.

**To markup text:**
1. On the **Review** tab, in the **Comment** group, click **Highlight Text** , **Underline Text** or **Cross-Out Text**.
2. Click and drag the pointer across the text you want to markup.
3. To add text feedback, double-click on the marked up text.
4. In the pop-up note, type your feedback.

**To update the appearance or properties of the Highlight, Underline, or Cross-Out Text:**
1. Right-click on the marked up text.
2. Click **Properties**.
3. Click the options you want to change.
4. Click **OK**.

**To delete a markup:**
1. Click on the marked up text.
2. Press the **Delete** key.

### 9.5 Adding stamps

Stamp comments give you a handy to add non-permanent stamp to pages. The built-in stamps (such as **Draft**, **Reviewed**, and **Approved**) give you a simple way to indicate the status of a file. Using the custom stamp feature, you can turn any image into your own stamp.

**To add a stamp to a PDF document:**
1. On the **Review** tab, in the **Comment** group, click the arrow below **Stamp** .
2. Click the stamp to use.
3. Click on the page where you would like the stamp to be placed.

**To add feedback to your stamp:**
1. Double-click on the stamp.
2. In the pop-up note, enter you text feedback.

To delete a stamp:
1. Click the stamp.
2. Press the Delete key.

To create a custom stamp:
1. On the Review tab, in the Comment group, click the arrow below Stamp.
2. Click the Create New Stamp option.
3. In the Stamp name box, enter a name for your stamp.
4. Click Browse and select the file to use as a stamp.
5. Click the options you want the stamp to use.
6. Click Save.

9.6 Markup with drawing tools

The drawing tools let you add drawing markups to your PDF documents. Each drawing you add has its own pop-up note, meaning you can add a text message to explain each drawing in more detail. You can change the look (color, opacity, and so on) of all your drawings, and you can edit the straight lines so they use arrows and other pointer styles.

Drawing shape tools include:
- Line
- Arrow
- Oval
- Rectangle
- Polygon
- Polygon Line
- Cloud
- Pencil (for freehand drawing)

To add a line, arrow, rectangle, or oval drawing markup:
1. On the Review tab, in the Comment group, click the Rectangle, Oval, Line, or Arrow tool.
2. Click on the page where you want to place the drawing.

To add feedback text to your drawing:
1. Right-click on the drawing.
2. In the pop-up note, enter your text feedback.

To update the appearance or properties of a drawing:
1. Right-click on the drawing.
2. Click Properties.
3. Click the options you want to change.
4. Click OK.

To make a line into an arrow drawing:
1. Right-click on the drawing.
2. Click Properties.
3. In the Start and End lists, click the options you want to use.
4. Click OK.

**To delete a drawing:**
1. Click on the drawing.
2. Press the Delete key.

**Tip:** You can change the default properties of your comments by right clicking on the drawing and choosing the Set Properties as Default option.

### 9.7 Attaching files

Just like attaching a paper file to another with a paperclip, the Attach File annotation tool enables you to attach and embed electronic files to your PDF files. The recipients of your files can see the paperclip icon where you have attached the files to your pages and then open, save and file them away for later use. The Attachments pane gives you a central place to view, insert, delete, and export all attachments in a document.

**To attach a file as a comment:**
1. On the Review tab, in the Comment group, click Attach File.
2. To place the file attachment, click on the page.
3. Select the file attachment, and then click Open.

**To update the appearance or properties of a file attachment comment:**
1. Right-click on the file attachment icon.
2. Click Properties.
3. Click the options you want to change.
4. Click OK.

**To open a file attachment:**
- Double-click on the file attachment on the page.

**To save a file attachment:**
1. Right-click on the file attachment.
2. Click the Save Embedded File to Disk option.
3. Click Save.

**To view all file attachments in a file:**
- On the Home tab, in the Show/Hide group, click Attachments.

### 9.8 Managing & viewing comments

On paper it's hard to keep on top of a document review cycle. Reviewing documents electronically lets you view all comments in the one place and group them the way that works best for you. Using the Comments pane lets you keep track of comments added to your PDF documents. The pane displays a list of each comment, its type, reviewer name, time stamp, the contents of any pop-up notes, text boxes call outs, and any replies.

**To view and organize all comments in the Comments pane:**
1. Do either of the following:
   - On the **Home** tab, in the **Show/Hide** group, click **Comments**.
   - Right-click on any comment and click **Show/Hide Comments List**.

2. In the Comments pane, click the **Sort By** button to group your annotations.

### To sort comments:
1. On the **Home** tab, in the **Show/Hide** group, click **Comments**.
2. In the Comments pane, click the Sort By button, and choose the way to group the comments.

#### 9.8.1 Sorting comments

Using the Comments pane lets you keep track of comments added to your PDF documents. The pane displays a list of each comment, its type, reviewer name, time stamp, the contents of any pop-up notes, text boxes call outs, and any replies.

### To sort comments:
1. On the **Home** tab, in the **Show/Hide** group, click **Comments**.
2. In the Comments pane, click the Sort By button, and choose the way to group the comments.

#### 9.8.2 Reply to comment

As part of the electronic document review cycle in Nitro PDF Professional, you can easily attach or tie your replies to other people’s comments. Then by using the Comments pane everyone in the review process can quickly see how comments are grouped and related.

### To reply to a comment:
1. Do either of the following:
   - In the Comments pane, highlight the annotation, and then click **Reply**.
   - On the page, right-click on the annotation, and then click **Reply**.
2. In the pop-up note, enter your feedback text.

#### 9.8.3 Hide all comments

If you want to view a document without all the comments displayed, you can hide all comments without the need for closing or deleting each pop-up manually.

### To hide all comments:
- On the **Review** tab, in the **Review** group, click **Hide All Comments**.

#### 9.8.4 Combine comments from multiple files

Nitro PDF Professional lets you take all comments from a PDF document and insert them into another PDF document. This is particularly useful when you receive feedback from multiple participants and each person has added their comments to a separate copy of the same document. It’s simply a matter of exporting all comments from each document and then importing them into the one version of the document.

### To export all comments from a PDF:
1. On the **Review** tab, in the **Review** group, click **Migrate**.
2. Click **Export Comments**.
To import comments into a PDF:

2. Click Import Comments.
3. Select the same file that contains different comments in it.

10. Security

With Nitro PDF Professional you can secure your PDF files with password- or certificate-based security, and once secured, your PDFs are protected with high-level 128-bit RC4 or 128-bit AES encryption.

You can apply two different sorts of security to control who can access your files and what they can do with the files when they receive them:

- **Open file.** This security locks a file so that only users with the correct 'key' can open the file. Depending on the type of security you use, only users with the correct password, or an approved digital ID will be able to open and view the file.
- **File usage permissions.** This security can lock (or turn off) particular functionality once a PDF file is opened. For example, you could disallow users from printing or copying text from the PDF. This type of control of document usage works particularly well for certificate-based security as you can allow different usage on a recipient-by-recipient basis.

To view the security in a file:

1. Click the Nitro PDF Button, and then click Document Properties.
2. Click the Security tab.

10.1 Permission settings

The usage permission settings let you restrict what features can be used when a recipient opens a file you have secured. This means, for example, that you can distribute documents that can’t be edited or printed, but can be opened and viewed. Using these permission settings with digital ID certificate-based security gives you even greater flexibility as you can set different permissions for each individual recipient of your file.

The usage permissions you can control include:

- **Printing.** Control the user’s ability to print the document, and at what resolution quality.
- **Modify document.** Control the user’s ability to edit the contents of a document.
- **Content copying or extraction.** Control the user’s ability to copy content from a document.
- **Content accessibility enabled.** Control the user’s ability to use accessibility tools to access PDF documents.
- **Commenting.** Control the user’s ability to add notes, text highlights, and drawing markups.
- **Form field fill-in or signing.** Control the user’s ability to fill in forms and digitally sign documents.
- **Document assembly.** Control the user’s ability to insert pages into and extract pages out of PDF documents.
- **Access for screen readers.** Allow text to be accessed by screen-reading software for users with a visual impairment.
10.2 **Password security**

Passwords allow you to restrict access and usage of your content to people who have the password used to secure the PDF file.

- **Open passwords.** These lock your file so only people with the correct password can open the file.
- **Permission passwords.** These lock particular functionality when a user opens your file. For example, you could stop recipients from copying text from or printing your document.

There are two ways to secure a PDF file using certificate security:

- **Password Security dialog.** In the Document Properties area of Nitro PDF Professional you can view security settings and manually apply security.
- **Security profiles.** The re-usable security profiles allow you to save custom security settings and then apply those settings to a document with one click.

**To apply password security:**

1. Do one of the following:
   - Click the **Nitro PDF Button**, and then click **Document Properties**. On the **Security** tab, in the **Security method** list, select **Password security** and click **Change Settings**.
   - On the **Secure and Sign** ribbon tab, in the **Secure Document** group, click **Password Security**.
2. In the **Password Security** dialog do one or more of the following:
   - If you want users to enter a password to open your file, click the **Require a password to the document** box, and then enter your password.
   - If you want to restrict permissions once a file is opened, click the **Require a password to change security settings and access specific functions** box, and then enter your password and click the options you want to restrict.
3. Click **OK** or **Finish**.
4. Click the **Nitro PDF Button**, and then click **Save** to apply the security.

**To apply password security with a security profile:**

1. Ensure that you have already created a security profile. To view and manage profiles, on the **Secure and Sign** ribbon tab, in the **Secure Document** group, click **Manage Profiles**.
2. On the **Secure and Sign** tab, in the **Secure Document** group, click the arrow below **Password Security**.
3. Click the security profile from the list.
4. Click the **Nitro PDF Button**, and then click **Save** to apply the security.

10.3 **Certificate security**

Digital IDs let you encrypt files that can only be opened and used by people who have exchanged certificates. Certificate-based security has many advantages over password-based security: documents can be opened without the need to remember passwords, Digital IDs cannot be shared or copied easily, and the one document can contain different security settings for each recipient of a file. For example, you may grant one person editing and printing privileges, while another is limited to just viewing the file.

**Getting Started**
Before you can receive files encrypted for your digital ID you must create your digital ID and then share its certificate with people you intend to share certificate-secured files with. You must have also received and imported another person’s certificate before you can encrypt files for their use.

Note: When using certificate-based security, remember to add your own certificate as an intended recipient – if you don’t you will not have access to the PDF once it has been secured.

There are two ways to secure a PDF file using certificate security:

- **Certificate Security dialog.** In the Document Properties area of Nitro PDF Professional you can view security settings and manually apply security.

- **Security profiles.** The re-usable security profiles allow you to save custom security settings and then apply those settings to a document with one click. Profiles can include details on the recipients you allow under the profile so it’s especially easy to secure documents the same way for each recipient each time.

**To apply certificate security:**

1. Do one of the following:
   - Click the Nitro PDF Button, and then click **Document Properties**. On the Security tab, in the Security method list, select **Certificate security** and click **Change Settings**.
   - On the Secure and Sign ribbon tab, in the Secure Document group, click **Certificate Security**.

2. In the Certify Security dialog, click on each contact you want to allow access to your secured file, and click **Add**. To restrict usage for each recipient as you add them, click the Restricted Permissions option and then choose what functionality you would like to restrict for that person.

3. Click OK or Finish.

4. Click the Nitro PDF Button, and then click **Save** to apply the security.

**To apply certificate security with a security profile:**

1. Ensure that you have already created a security profile. To view and manage profiles, on the Secure ribbon tab, in the Secure Document group, click **Manage Profiles**.

2. On the Secure and Sign tab, in the Secure Document group, click the arrow below **Certificate Security**.

3. Click the security profile from the list.

4. Click the Nitro PDF Button, and then click **Save** to apply the security.

### 10.4 Security profiles

The beauty of security profiles is that you can re-use them repeatedly. So, instead of re-entering passwords or re-adding recipient names every time, you simply open up the file in Nitro PDF Professional and select the security profile from a list. If you’re using certificate-based security and you’re regularly sending files to the same people, setting up security profiles will save you a lot of time.

**To view your security policies:**

1. On the Secure and Sign tab, in the Secure Document group, click **Manage Policies**.

2. In the Security profiles pane, click on each policy to view its details.

**To edit a security policy:**
2. In the Security profiles pane, click on the policy and then click Edit.
3. In the Security Profile dialog, update the name and description and then click Next.
4. Select and update the settings you would like to update.
5. Click Finish.

To add a security profile:
2. Click New.
3. In the New Security Profile dialog, enter a name and description for your profile, and then click Next.
4. Do one or more of the following:
   • If you want users to enter a password to open your file, click the Require a password to the document box, and then enter your password.
   • If you want to restrict usage permissions once a file is opened, click the Require a password to change security and access specific functions box, and then enter your password and click the options you want to restrict.
5. Click Finish.

To delete a security policy:
2. In the Security profiles pane, click on the policy and then click Delete.

10.5 Digital IDs

A digital ID is much like paper-based identification such as a passport. It can prove who you are and give you special rights to do particular things. In the case of digital IDs in Nitro PDF Professional, your digital ID can let you make your PDF files tamper proof, as well as give you special access to files from users who have approved your digital ID. The beauty of digital IDs when securing a document is that you can change access and usage rights on a user-by-user basis.

Digital IDs are comprised of a public and private key. The public key contains a certificate and identifying information, and this is what you share with other users. Once other users have your public key they can secure (encrypt) documents that you may be able to access and use. The private key is the part of the digital ID that is never shared and is the part of the ID that unlocks (decrypts) files that you have been granted access to and usage of.

Nitro PDF Professional supports the use of two types of digital IDs:
- **PKCS#12 digital ID file.** This type of digital ID is more flexible because you can use the same ID on multiple computers. For example, if you had an office workstation and a notebook with the same certificate installed, you could open the same secured PDF file on both computers. The digital ID remains secure when moved between computers as you must enter a password when you import it to your My Digital IDs.
- **Windows Certificate Store.** This type of digital certificate locks the ID to a user on a particular computer and cannot be copied and imported to another computer.

10.5.1 My Digital IDs

The My Digital IDs feature in Nitro PDF Professional lets you to create, manage, and store your digital IDs. For most users you will probably only need the one digital ID.
Tip: The Trusted Contacts feature is where you store certificates from other people with whom you are sharing secured documents.

To create a digital ID:
1. On the Secure and Sign tab, in the Digital IDs group, click My Digital IDs.
2. In the My Digital IDs dialog, click New.
3. Click the type of digital ID to use.
4. In the Identity boxes, enter information about yourself.
5. In the Intended Usage list, click the type of security to use.
6. Click Next.
7. Click Browse, choose a location to save the ID, and then enter a file name.
8. Enter a password.
9. Click OK.

To import a digital ID:
1. On the Secure and Sign tab, in the Digital IDs group, click My Digital IDs.
2. In the My Digital IDs dialog, click Import.
3. Select the digital ID and click Open.
4. Click Close.

To export a digital ID:
1. On the Secure and Sign tab, in the Digital IDs group, click My Digital IDs.
2. In the My Digital IDs dialog, click Export.
3. Click Save data to file option, and then click Next.
4. Enter a name for the ID and then click Save.

To export a digital ID via email:
1. On the Secure and Sign tab, in the Digital IDs group, click My Digital IDs.
2. In the My Digital IDs dialog, click Export.
3. Click Send data to others via email, and then click Next.
4. Type the email address to send your digital ID to, and then click Send.

10.5.2 Trusted contacts

When another user shares their public key certificate with you and vice versa, and you both add each other to your Trusted Contacts list, you then both have the ability to encrypt files for each other’s digital ID.

With Nitro PDF Professional you can add people to your Trusted Contacts list by importing their public key certificate manually, or you can share both your public key and their public key in the one process by using the Request Contacts feature.

To add a trusted contact ID:
1. On the Secure and Sign tab, in the Digital IDs group, click Trusted Contacts.
2. Click Add, select the certificate, and then click Open.

To export an ID:
1. On the Secure and Sign tab, in the Digital IDs group, click My Digital IDs.
2. Click Trusted Contacts.
3. Highlight the contact to export, and then click Export.
4. In the Save As dialog, name the certificate and click Save.

To share public key certificates:
1. On the Secure and Sign tab, in the Digital IDs group, click My Digital IDs.
2. Highlight the contact to share with, click Request.
3. Enter your contact details.
4. Click the Include my certificate in email checkbox, and then select the certificate to share.
5. Click Next.
6. Enter the recipient’s email address, and then click Send.
7. Once the information and certificate are moved to your email client, click Send.

11. Digital signatures

A digital signature is like a paper-based signature – each giving you a method for adding a unique identifier to a document. Both provide you with an easy way to show a person signed a particular document at a particular time, but a digital signature goes further as it can ensure that the document content has not been tampered with after it was signed. In addition, the document version history can let recipients see when a document was signed and see when any changes were made to it. This revision history is encrypted and stored inside the PDF and can be viewed at anytime via the Signatures pane.

To digitally sign a PDF document, you must have a digital ID, and to verify other people’s signatures, you must first share your digital IDs and add each other to your Trusted Contacts list.

- Edit signature fields
- Insert blank signature field
- Customizing signature appearance
- Create a digital ID
- Add people to your Trusted Contacts

11.1 Using digital signatures

Each time a signature is applied to a document, a new message digest is created. This digest stores an encrypted ‘hash’ version of the document (taken at the time of signing) and then embeds it along with the signature inside the document. When a recipient receives the file and validates the signature, another digest is generated and then compared with the original digest to confirm they have remained the same.

Tip: The embedded certificate verifies the signer’s identity, while the message digest verifies the content has not changed.

To digitally sign a document:
1. On the Secure and Sign ribbon, in the Signatures group, click Sign.
2. One a page, click and drag to place where you would like the signature to appear.
3. In the Apply Digital Signature dialog, select the digital ID to use, and then click Next.
4. Select the reason for signing from the list, or type your own reason for signing.
5. Click the option to save the signed PDF as a new file or save it to the current document.
6. Click Finish.
11.1.1 Customizing signature appearance

Your digital signatures can be easily customized to make just the information you want to share visible and used to display your physical signature, a corporate logo, or whatever other graphic you'd like to appear alongside your signature. You can edit the appearance of your signature at the time of signing a document, or at any time by heading to the preferences.

To customize a signature's appearance during signing

1. Do one of the following:
   - On the Secure and Sign tab, click Sign and then click on the page to place your signature
   - Click on a digital signature field that is already on the page
2. Click Continue Signing
3. Select the digital ID to use and click Next
4. Do one of the following:
   - To choose an existing signature, select it from the Use this signature appearance list
   - Click New and create and save a new signature appearance
5. Click Finish

To edit the appearance of a digital signature

1. Click the Nitro PDF Button, click Nitro PDF Preferences, and then click Security
2. In the Signature appearances list, select the signature and then click Edit
3. Choose the text-based information to appear with your signature
4. To add a graphic, click Graphic from file, select the file, and then click OK
5. Click OK

To create a new digital signature appearance

1. Click the Nitro PDF Button, click Nitro PDF Preferences, and then click Security
2. Click New
3. Name your signature appearance
4. Choose the text-based information to appear with your signature.
5. To add a graphic, click Graphic from file, select the file, and then click OK
6. Click OK

Using handwritten signatures

To make your physical signature appear in your digital signature, it's just a matter using a scanner to make a digitized copy of it and then following the step above to set up a new digital signature appearance. You can digitize your signature using just about any scanner and the software that comes with it, or if you like use Nitro Pro's Create PDF From Scanner feature -- the instructions below show you how to do it with this way.

1. Sign a piece of paper and place it onto your scanner
2. Open Nitro PDF Professional
3. On the Home tab, in the Convert group, click the arrow below Create PDF
4. Click Create PDF From Scanner.
5. In the Create PDF From Scanner dialog, select your scanner and then specify the destination.
6. Click Scan to open your default scanning software.
7. Select the mode of scanning—color, grayscale, or monochrome/black-and-white.
8. Select the menu command to return to Nitro PDF Professional.
9. Select the Finish option to end your scanning job.
10. Save your PDF file.

### 11.2 Viewing and validating certificates and signatures

You can view and verify the status of your signatures by looking directly at them on your pages or by viewing them all via the Signatures pane.

**To open the Signature pane:**
- On the **Home** ribbon tab, in the **Show/Hide** group, click **Signatures**.

Signatures are validated when a document is opened and then automatically re-validated whenever changes occur in the document. You can view the status of each by looking in the Signatures pane, or by clicking on the signatures themselves. To check the status at a glance, use the icons that appear along with the signature.

<table>
<thead>
<tr>
<th>Status</th>
<th>Icon</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid</td>
<td>![Valid Icon]</td>
<td>This document is certified and the document has not changed in a way not permitted by the certificate.</td>
</tr>
<tr>
<td>Valid</td>
<td>![Valid Icon]</td>
<td>The signature is valid and the document has not been changed since this signature was added.</td>
</tr>
<tr>
<td>Change view</td>
<td>![Change View Icon]</td>
<td>The certificate is valid, however the current view of the document is not the same as when it was signed.</td>
</tr>
<tr>
<td>Unknown</td>
<td>![Unknown Icon]</td>
<td>The certificate is not trusted as it could not be properly verified. The document does not appear to have been changed.</td>
</tr>
<tr>
<td>Unknown</td>
<td>![Unknown Icon]</td>
<td>The certificate is not trusted as it could not be properly verified. Unable to determine if document has been changed.</td>
</tr>
<tr>
<td>Invalid</td>
<td>![Invalid Icon]</td>
<td>The certificate is invalid or Illegal changes have been made to the document.</td>
</tr>
</tbody>
</table>

### 11.3 Certifying PDF files

As the author of a document, when you certify it, you attest to its contents and control what (if anything) can be done to it while retaining its certified status. If changes occur to the document that you have not permitted, then the document is invalidated and the certification is revoked.

**Tip:** Always certify the PDF files you author rather than sign them.

If you are the author of a PDF file that you want to maintain the integrity of, you apply a certifying signature by using the Certify feature. When you certify (rather than just add a digital signature) you can control document usage in the following ways:

- **Disallow any changes.** Disables all tools that can be used to change a file (including editing,
commenting, form filling and signing). If any change is made to the document after certification, its certificate becomes invalid.

- **Only allow form fill-in actions.** Disables all tools that can be used to change a file, except for the form filling and signing tools. An example of when you would use this is when collecting information from users via an official form that requires the user to enter their information but must not allow them to change the form you have designed.
- **Only allow commenting and form fill-in actions.** Disables all tools that can be used to change a file, except for the form filling, signing, and commenting tools. An example of when you would use this is when reviewing a contract that may require signatures and comments during the reviewing stage.

**Why certify a document?**
- When you want people to be able to sign, form fill or annotate a PDF file without invalidating the certificate.
- To attest you are the document’s author.
- To vouch for its contents.
- To specify what changes are permitted for it to stay certified.
- To automatically disallow functionality such as inserting pages, changing text, and editing form field properties.

**Tip:** PDF files can be certified only once, but if permissions allow, can be digitally signed many times. This is the benefit of certifying the files you author rather than just signing it.

**To certify a PDF document:**
1. On the **Secure and Sign** ribbon, in the **Signatures** group, click **Certify**.
2. On the **Certify Document** dialog, choose the actions you want to permit from the **Permitted actions** list.
3. Click **Next**.
4. Select the digital ID with which to certify and choose whether to make the certificate visible or not.
5. Click **Next**.
6. If you chose to make the certificate visible, click on the page where you would like it to appear.
7. On the **Certify Document** dialog, do the following:
   - Choose a reason for signing the file from the **Reason for signing document** list, or enter your own reason.
   - Choose to save the certification to the current document or save as a new document.
   - Choose how you would like the certificate should appear.
8. Click **Finish**.

**Note:** When sharing certified PDF files with other users, the PDF viewer they use must support the functionality for certification and signatures to work correctly. Nitro Pro, Adobe Acrobat and Adobe Reader can all share certified and signed PDF files between them.

### 12. Forms

Forms are one of the most common uses of PDF documents. Using form tools and JavaScript you can create dynamic, interactive documents, and create alternatives for writing complex HTML code when hosting forms on web sites. There are seven form tools in Nitro PDF Professional used for creating PDF forms. Each tool offers a number of different settings to control form behavior and appearance.

When a PDF form is opened in Nitro Pro, the Information bar (above the document pane area) appears, notifying the user that the file contains forms fields.
Forms preferences

The forms preferences give you extra control over how you work with PDF forms. Preferences include:

- **Automatically calculate field values.** A PDF form containing many complex and interdependent form calculations can affect how well a PDF viewer performs. If you use this kind of form regularly, or know you’re about to fill in such a form, consider turning off this preference.

- **Highlight form fields.** A PDF form can be difficult for people to use as it is not always visibly clear what areas of the file must be filled in. When this preference is turned on, each time a form is opened in Nitro Pro, all form fields will display using the background color specified here. In addition, for form fields that must be filled in, you can specify a different color.

- **Double click form field opens.** There are two different ways when designing forms to get to the key properties and appearance settings: firstly via the Properties context ribbon, and secondly via the Properties dialog. This preference allows you to choose which method you will use when you double click on a form field to edit it.

**To edit form preferences:**
- Click the Nitro PDF Button and then click **Nitro PDF Preferences**.
- Click **Forms** and update your preferences.
- Click OK.

12.1 Filling forms

Nitro PDF Professional includes all the tools you need for filling, saving, printing and submitting PDF forms.

**Tip:** When you open your form in Nitro Pro, the Information bar (above the document pane area) will appear, letting you know that the file contains form fields. To show you where the form fields are, all fields are highlighted with a colored background.

**To print a form:**
- Click the Nitro PDF Button, and then click **Print**.

**To email a form:**
- Click the Nitro PDF Button, move the pointer to the **Send** slide out option, and then click **Email**.

12.2 Designing forms

The form creation tools are all located on the **Form** ribbon tab in Nitro PDF Professional. To create a field you select one of the form tools and drag open a rectangle marquee to define the field size. When you release the mouse button the field icon appears as a rectangle for all field types with the exception of the radio button field appearing as a circle.

Nitro Pro includes a unique the tool that lets you save your form field appearance settings. For example, if you regularly use several different styles of push buttons (colors, styles, borders, etc.), you can add these to the Appearance gallery and reuse them for future forms. (See the Reusing form field appearance settings)
To add a form field:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, click the field type to add.
3. On the page, drag the pointer where you want the field to appear.

To edit a form field:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click Edit All Fields.
3. Double-click the field to begin editing it.

Using form field controls

There are seven different form tools. Each tool is used to create the respective field type. To create a field, first select the tool for the kind of field to be created, and then drag the pointer on the page where you want to position the field. After creating a field, you can move the field by selecting the respective tool and dragging it around the page. You can size a field box by dragging any one of the corner handles in or out. If you need to change field attributes, double-click on the form field to access its properties.

The types of fields you can create in Nitro Pro include:

- **Push Button**. Buttons are used for hyperlinking and invoking actions. You might create a button to clear data in a form, or to submit form data to a web address or email account.
- **Check Box**. The attributes for Check Box and Radio Buttons are almost identical. Check Boxes are used for checking a number of different options such as a grocery list where the user checks all the items to be purchased at the grocery store.
- **Radio Button**. Radio Buttons can be used like Check Boxes, but the intent for this field type is for either/or conditions. For example, you might use radio buttons to identify a credit card type where only one response is acceptable. As one button is marked, the remaining buttons assigned for a response to the same question are turned off. All the behavior and conditions assigned to check boxes and radio buttons are identical. The distinction between the two form field types is the appearance. Check boxes are square and radio buttons are round shapes.
- **Combo Box**. Combo Boxes and List Boxes are used when you want to create menus and offer respondent’s options for selecting choices from a list. The Combo Box uses a down pointing arrow to open the list.
- **List Box**. List Boxes are scrollable lists. With Combo Boxes you are limited to assigning a single response from menu options. List Boxes enable you to assign multiple responses to the menu items.
- **Text Field**. Text fields are used for respondents to type text in the field box. Text can be either alpha or numeric values.
- **Signature Field**. Signature fields are recipients to apply their digital signature to.

Form field attributes

The different types of form fields have some attributes the same, as outlined below, but because the form fields differ greatly in their design and intent, you have unique attribute assignments you can add to any
given field type. For example, when creating text fields, you have options for data formatting, validation, and calculations. When using button fields, you have more options for adding appearances where icon images can be used as button faces. When using combo and list boxes you have options for adding menu names.

**General**

- **Name.** As each field is created, Nitro PDF Professional automatically names the field according to field type and order. For example, if you have two text fields on a page and create a third text field, then Nitro PDF Professional defaults the name to Text3 (Text for the field type and 3 for the next field of the same type). Drawing your first button field results in Button1 for the field name.
- **Tooltip.** Type text in the Tooltip text box and a tooltip appears below the cursor when a user places the mouse cursor above the field.
- **Visibility.** In most cases, a form field will be visible. You have three additional options, Hidden, Visible but does not print, and Hidden but printable.
- **Orientation.** You can choose rotation angles in 90-degree increments.
- **Read Only.** A Read Only field is not editable. Checking the Read Only check box prevents a user from editing the field data.
- **Required.** Check the box when a field is required for completion before submitting form data.
- **Locked.** This checkbox locks a field in place on the document page and prevents changes to the attribute settings. If you need to change attributes, first uncheck the checkbox that is locked.

**Appearance**

- **Border Color.** The rectangle (or circle) border can be assigned no color or a color from the pop-up color palette. Click the Custom Color option and you can assign any color supported by Windows.
- **Line Width.** From a pop-up menu select Thin, Medium, or Thick to change the rectangle (or circle) border stroke weight.
- **Line Style.** From the pop-up menu select Solid, Dashed, Beveled, Inset, or Underlined.
- **Fill Color.** The contents of the rectangle (or circle) can be filled with a color using the same color palette options as you have when adding color to line widths.
- **Font Name.** The typeface you assign to a field appears only when text is added to a field, like when a user types text in a text field. Text changes do not affect tooltips or text appearing in the Form Properties dialog box.
- **Font Size.** All fields except signature fields accept font size changes. The default size is Auto. When you create a field box, Nitro PDF Professional automatically sizes the text to fit the vertical size. From a drop down menu you can select fixed-point sizes or enter a value in the Font Size text box.
- **Font Color.** The same color options you have for appearances can be applied to fonts.

**Action**

You can assign the same action types as you have available with bookmarks and links. Actions attributes offer you two primary options—the trigger and the action type.

- **Select Trigger.** The Trigger is the mouse action. An action is performed on a mouse behavior from the following options:
  - **Mouse Up.** This is the default trigger. When the mouse button is released, the assigned action is performed.
  - **Mouse Down.** When the mouse button is depressed, the assigned action is performed.
  - **Mouse Enter.** When the cursor enters a field, the assigned action is performed.
  - **Mouse Exit.** When the cursor exits a field, the assigned action is performed.
  - **On Focus.** When a user tabs into the field, the assigned action is performed.
  - **On Blur.** When a user tabs out of the field, the assigned action is performed.
- **Select Action.** All the same action types you have available with bookmarks and links are available...
with form fields. Click the Select Action option and choose an action type from the drop down menu.

The Actions box expands as actions are identified to accommodate a description of the assigned action(s). Use this box to view at a glance actions assigned to form fields. The box itself is not editable, but you can double-click on items to change the action. For example, when you use the Open a web link action, double clicking on the web link reported in the Actions box opens the Open a web link dialog box where a URL is typed. You can edit the URL and the change is reflected back in the box. Below the Actions box are buttons that offer you options for moving actions up or down in the box.

An Edit button opens the dialog box where an action is assigned, and the Delete button is used to delete a selected action in the box.

12.3.2 Creating button fields

Of all the field types, button fields have the broadest use. You can add buttons on PDF forms to perform a variety of actions associated with filling out a form or you can use buttons on PDF documents not intended for form use. Buttons can be used for items in any PDF such as navigational tools in a PDF design, hyperlinks for a variety of different actions, and just about any other condition that sparks your imagination.

Tip: You can edit general- and appearance-related attributes via the Properties context tab or the Properties dialog, depending on your preferences. (See more about forms preferences.)

To add a push button field:
1. Open the PDF in Nitro PDF Professional.
2. On the Forms ribbon tab, in the Fields group, click Push Button.
3. On the page, drag the pointer where you want the field to appear.
4. Double-click on the field and do one of the following (depending on your preferences):
   - In the Properties context tab, name the field and set its appearance settings.
   - In the Properties dialog, name the field and set its appearance settings.
5. Do either of the following:
   - If you’re using the Properties context tab, in the More group, click Properties and then Options.
   - If you’re using the Properties dialog, click the Options tab.
6. Set the options. If you want to use an icon appearance or have text appear inside the button, make choices in the Options category.
7. Select the trigger. By default the Mouse Up behavior is assigned. In most cases you’ll want to leave the trigger action as the default.
8. Assign an action. Open the Select Action drop down menu and choose an action to assign to the button.

To edit a push button form field:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click Edit All Fields.
3. Double-click the field to begin editing its attributes.

12.3.3 Creating check box fields

In almost all cases you should use unique field names when creating form fields. If you use the same name for a field, like a text field, data typed in the field box is replicated for all fields with the same name. The exception to the rule is when creating check box and radio button fields. If you want one check box or radio button in a group to be unchecked as another check box or radio button is checked, you use the same field name. Both these field types have an option for adding an export value. When you create fields with the same name, you use different export values to distinguish one choice from another.
To add a check box field:
1. Open the PDF in Nitro PDF Professional.
2. On the **Forms** ribbon tab, in the **Fields** group, click **Check Box**.
3. On the page, drag the pointer where you want the field to appear.
4. Double-click on the field and do one of the following (depending on your preferences):
   - In the **Properties** context tab, name the field and set its appearance settings.
   - In the **Properties** dialog, name the field and set its appearance settings.
5. Do either of the following:
   - If you’re using the **Properties** context tab, in the **More** group, click **Properties** and then **Options**.
   - If you’re using the **Properties** dialog, click the **Options** tab.
6. Select **Options**. Choose a style for the check box appearance from the **Check Box Style** list. Click in the **Export Value** field and add a value. If you have two fields that you want to use as Yes and No responses, use the same name for the two fields and add an export value of Yes in one field and No in the other field.

To edit a check box form field:
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, in the **Fields** group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click **Edit All Fields**.
3. Double-click the field to begin editing its attributes.

### Creating radio button fields

Radio buttons can be assigned the same attributes as check box fields. You use radio buttons more often for either/or responses. When you create check boxes you can uncheck a checkbox by clicking on it. The only way to uncheck a radio button is to clear a form or check another button that turns off companion radio button checkmarks.

To add a radio button field:
1. Open the PDF in Nitro PDF Professional.
2. On the **Forms** ribbon tab, in the **Fields** group, click **Radio Button**.
3. On the page, drag the pointer where you want the field to appear.
4. Double-click on the field and do one of the following (depending on your preferences):
   - In the **Properties** context tab, name the field and set its appearance settings.
   - In the **Properties** dialog, name the field and set its appearance settings.
5. Do either of the following:
   - If you’re using the **Properties** context tab, in the **More** group, click **Properties** and then **Options**.
   - If you’re using the **Properties** dialog, click the **Options** tab.
6. Select **Options**. Choose a style for the radio button appearance from the **RadioButton Style** drop down menu. Click the **Export Value** field and add a value. If you want all radio buttons checked when one button is selected, check the box for The same name and values are selected in unison.

To edit a radio button form field:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click Edit All Fields.
3. Double-click the field to begin editing its attributes.

### 12.3.5 Creating combo box fields

Combo Boxes provide users a drop down menu. Only a single response can be selected from the menu. You add menu topics for combo boxes in the Options category in the Form Properties.

To add a combo box field:
1. Open the PDF in Nitro PDF Professional.
2. On the Forms ribbon tab, in the Fields group, click Combo Box.
3. On the page, drag the pointer where you want the field to appear.
4. Double-click on the field and do one of the following (depending on your preferences):
   - In the Properties context tab, name the field and set its appearance settings.
   - In the Properties dialog, name the field and set its appearance settings.
5. Do either of the following:
   - If you're using the Properties context tab, in the More group, click Properties and then Options.
   - If you're using the Properties dialog, click the Options tab.
6. Select Options. Click in the Item field and enter a name in the text box. Click the Add button to add the text to the Items list. Type an export value in the Export Value text box. Continue adding items following the same steps.
7. Click the Sort Items check box if you want the list sorted in alphabetical order. Select items in the list and click the Down/Up buttons to rearrange the items in the list manually. Select an item and click Delete to remove it from the list.
8. If you want a user to type an item instead of choosing from the list, click the Allow custom text input check box.
9. Format. If you want a format other than text, such as a date or custom format, chose an option from the Select format category drop down menu.
10. Validation. If you want the field data to be validated, you need to know JavaScript. Check Run custom validation script and type the JavaScript code to validate the field data.
11. Calculate. If the field is to be calculated, check an option for calculating data.

To edit a combo box form field:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click Edit All Fields.
3. Double-click the field to begin editing its attributes.

### 12.3.6 Creating list box fields

List Boxes provide users scrollable menus. You can define attributes for list boxes to accept only a single response or multiple responses. Adding items to the menu list are performed similarly to defining responses in combo boxes.

Tip: You can edit general- and appearance-related attributes via the Properties context tab or
To add a list box field:
1. Open the PDF in Nitro PDF Professional.
2. On the **Forms** ribbon tab, in the **Fields** group, click **List Box**.
3. On the page, drag the pointer where you want the field to appear.
4. Double-click on the field and do one of the following (depending on your preferences):
   - In the **Properties** context tab, name the field and set its appearance settings.
   - In the **Properties** dialog, name the field and set its appearance settings.
5. Do either of the following:
   - If you're using the **Properties** context tab, in the **More** group, click **Properties** and then **Options**.
   - If you're using the **Properties** dialog, click the **Options** tab.
6. Select **Options**. Click **Item** and type a name in the text box. Click the Add item to add the text to the Items List. Type an export value in the Export Value text box. Continue adding items following the same steps.
7. Click **Sort items** if you want the list sorted in alphabetical order. Select items in the list and click the Down/Up buttons to rearrange the items in the list manually. Select an item and click **Delete** to remove it from the list.
8. If you want a user to select multiple items for the response, check **Multiple Selection**.

To edit a list box form field:
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, in the **Fields** group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click **Edit All Fields**.
3. Double-click the field to begin editing its attributes.

### 12.3.7 Creating text fields

The most common field type on PDF forms is the text field. Text fields permit respondents to add alpha text and/or numeric values. You can format text fields in a number of different ways to insure fields are completed properly. You can add custom format scripts, validate data, assign actions, and perform calculations on text fields.

Tip: You can edit general- and appearance-related attributes via the Properties context tab or the Properties dialog, depending on your preferences. (See more about forms preferences.)

To add a text field:
1. Open the PDF in Nitro PDF Professional.
2. On the **Forms** ribbon tab, in the **Fields** group, click **Text Field**.
3. On the page, drag the pointer where you want the field to appear.
4. Double-click on the field and do one of the following (depending on your preferences):
   - In the **Properties** context tab, name the field and set its appearance settings.
   - In the **Properties** dialog, name the field and set its appearance settings.
5. Do either of the following:
   - If you're using the **Properties** context tab, in the **More** group, click **Properties** and then **Options**.
   - If you're using the **Properties** dialog, click the **Options** tab.
6. Select **Options**. Click **Alignment** and select from drop down menu items text alignment for left, center, or right.
7. Add text in the **Default Text** box if you want text to appear as a default for the field. Something like a zip code or country might be used where most of your respondents are likely to come from the area.
you add for the default text.
8. Check **Multiple Line** if you want the text to appear on multiple lines and check **Scroll long text** to have the text scroll in a box.
9. Click **Limit of characters** and enter the number of characters you want to limit a response to. Something like a zip code would work here.
10. Check **Password** to password secure a field.
11. Check **Comb of Characters** to create a comb field. (Note: You must turn off all other checkboxes to use this feature.) Comb fields are designed for characters to be added in individual boxes. The number of boxes are defined in the text box that appears after you check the **Comb of Characters** box.
12. **Format.** If you want a format other than text, such as a date or custom format, then choose an option from the **Select format category** drop down menu.
13. **Validation.** If you want the field data to be validated, you need to know JavaScript. Check **Run custom validation script** and type the JavaScript code to validate the field data.
14. **Calculate.** If the field is to be calculated, check an option for calculating data.

**To edit a list box form field:**
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, in the **Fields** group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click **Edit All Fields**.
3. Double-click the field to begin editing its attributes.

### 12.3.8 Creating signature fields

The signatures field lets you add an empty digital signatures field to a document. When a signer clicks on the field a dialog opens prompting them to certify and/or digitally sign the file with their digital ID.

**To create a blank signature field:**
1. On the **Forms** ribbon, in the **Fields** group, click **Digital Signature**.
2. One a page, click and drag to place the signature where you would like it to appear.
3. Double-click on the field and do one of the following (depending on your preferences):
   - In the **Properties** context tab, name the field and set its properties, appearance and actions.
   - In the **Properties** dialog, name the field and set its properties, appearance and actions.

**To edit a digital signature form field:**
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, in the **Fields** group, do either of the following:
   - Click the field type that corresponds to the field you want to edit.
   - Click **Edit All Fields**.
3. Double-click the field to begin editing its attributes.

### 12.3.9 Creating multiple fields

When creating many of the same type of form field, the quickest and easiest method is to use the Make Copies tool. Just setup the form field with the appearance and other properties you’d like all the fields to be like and then chose how many rows and columns you want.

**To create a batch of similar fields:**
1. Open the PDF in Nitro PDF Professional.
2. Create the exact form field you’d like to copy.
3. Select the form field.
4. On the Properties context tab, in the Tasks group, click Make Copies.

5. Choose the number of rows and columns of fields you’d like to create.

12.4 Setting tab order

If you haven't created your form fields in the order they should be used when tabbing, you can manually set the tab order late in the design stage.

To set the tab order:
1. Open the PDF in Nitro PDF Professional.
2. On the Forms tab, in the Setup group, click Set Tab Order.
3. Click on the form fields in the order you would like them to be tabbed through.
4. To finish, click on another tool.

12.5 Editing, aligning and spacing multiple fields

Nitro PDF Professional allows you to select multiple form fields, meaning you can edit common appearance properties and fix alignment issues faster. You can edit the alignment via the Alignment context tab or context (right-click) menu. To edit the appearance of multiple form fields, you can use the Properties context tab or Properties dialog.

Tip: You can select multiple field types using the Edit All Fields tool. Once you've selected it, either click and drag the marquee around the fields to select them all, or click on fields (while holding down Ctrl) to select them one at a time.

To edit the appearance of multiple fields:
1. On the Forms ribbon tab, in the Fields group, click Edit All Fields.
2. Select the fields using one of the following methods:
   • Click and drag the cursor around all the fields.
   • Click on each field while holding down the Ctrl key.
3. Do either of the following:
   • On the Properties context tab, click any options in the appearance group.
   • Right-click, click Properties, and then change any of the appearance options.
4. Click OK.

To adjust the alignment and spacing of form fields:
1. On the Forms ribbon tab, in the Fields group, click Edit All Fields.
2. Select the fields using one of the following methods:
   • Click and drag the cursor around all the fields.
   • Click on each field while holding down the Ctrl key.
3. Do either of the following:
   • On the Alignment context tab, click any option to change the alignment or spacing between selected fields.
   • Right-click and click any option to change the alignment or spacing between selected fields.

Tip: Using the Alignment context tab can be quicker to use and makes it easier to reverse your changes as the Undo button appears immediately above the alignment tools.
12.6 Reusing form field appearance settings

Nitro PDF Professional includes a unique tool that allows you to save the appearance properties used on a form field -- including colors, border and line style -- and reuse it to apply to future form fields. All the appearances you create appear in the Properties context tab.

**How to create a form field appearance:**
1. Create a form field using the appearance settings you would like to save and then select it.
2. On the Properties context tab, in the Appearance group, click the down arrow.
3. Click **Save Selection as New Appearance**.
4. Name the appearance.
5. Click OK.

**How to apply a form field appearance:**
1. Select the form field(s) to apply the appearance to.
2. On the Properties context tab, in the Appearance group, click the appearance to use.

12.7 Importing and exporting form data

You can export data from forms and Nitro PDF Professional exports the data in a FDF (form data format). An exported data file is much smaller than a PDF document. You can email an FDF file to another user who can import the data in a PDF file, or you can use FDF files locally and import data into your forms. When you import data into a PDF file, the file must have the exact same name fields (including case sensitivity) as were named in the file exporting the data. Nitro PDF Professional ignores all field data where the field names do not match between the form exporting the data and the form importing the data.

**To export data from a PDF document:**
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Form Data group, click **Export**.
3. Type a name for the file.
4. Click **Save**.

**To import data into a PDF document:**
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Form Data group, click **Import**.
3. Select the file to import.
4. Click **Open**.

12.8 Resetting form data

One of the more common buttons you create on PDF forms is a button that permits a user to clear populated fields. This is a handy button for users when they need to start over filling in a form. Nitro PDF Professional also has a Reset button in the ribbon for when a form doesn't include the button.

**To reset form data:**
1. Open the form in Nitro PDF Professional.
2. On the Form ribbon tab, in the Form Data group, click **Reset**.

**To create a reset button:**
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, click **Push Button**.
3. On the page, drag the pointer where you want the button to appear.
4. Name the field `resetForm` and set **General** and **Appearance** properties.
5. Select **Layout** in the **Options** properties and select **Label** only. Click the **Label** field and enter `Reset Form`.
6. Click **Select Action** and select **Reset a form** from the drop down menu.
7. Click **Add** and do one of the following:
   - Click **Deselect All**. Press Control and click each field you want to clear, if the number of fields to clear are fewer than the total number of fields in the list.
   - Click **Select All**. Press Control and click each field you want to eliminate from clearing data, if the number of fields to clear are greater than the total number of fields you don’t want to clear.
8. Click **OK**.

### 12.9 Submitting form data

If you want data to be submitted to a URL or email address, you should create a submit button. If you submit data to a URL, be aware that you need server-side programming to collect and route data. When emailing data you have several options for including and excluding certain form field data.

**To create a submit button:**
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, click **Push Button**.
3. On the page, drag the pointer where you want the button to appear.
4. Name the field `submitForm`, and then set **General** and **Appearance** properties.
5. Select **Layout** in the **Options** properties and select **Label only**. Click the **Label** field and enter `Submit Form`.
6. In the **Actions** tab, click **Select Action** and select **Submit a form** from the drop down menu.
7. Click **Add** and then click the **Submit to** list to choose the submission method.
8. Select the fields. Click **All Fields** or **Only Fields**, and click **Select fields** to select the fields you want to submit. Check the boxes for **Include No Value Fields** and/or **Convert Dates to Standard Format** if desired.
9. Click **OK**.

### 12.10 Showing/Hiding fields

You can select fields individually, and show or hide them in the General properties, or you can write JavaScripts to show and hide fields. As another option, you can create a button and set the button action to show and hide fields.

**To show/hide fields:**
1. Open the PDF in Nitro PDF Professional.
2. On the **Form** ribbon tab, click **Push Button**.
3. On the page, drag the pointer where you want the button to appear.
4. Name the field and then set **General** and **Appearance** properties.
5. In the **Options** tab, select **Layout** and select **Label only**. Click the **Label** field and enter `Show/Hide Fields`.
6. In the **Actions** tab, click **Select Action** and select **Show/Hide Fields** from the drop down menu.
7. Do one of the following:
• Click Show.
• Click Hide.
8. Click OK.

12.11 Calculating field data

Nitro PDF Professional supports field calculations using several methods. The Nitro PDF Professional built-in calculation formulas are an easy means for creating simple, and quite restricted, field calculations. Using Simplified Field Notation and JavaScripts are much more sophisticated and require some programming knowledge. If your calculation needs are limited to summing or averaging data, you don’t need to worry about any programming.

Calculations involve, in one-way or another, the use of text fields. You can perform a calculation using any field type, but if you want the results of your calculations reported on a form, you need to have a text field that either calculates the data and places the result in the field performing the calculation, or calculate data in another field type and send the data to a text field.

To create a calculation:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, click Text Field.
3. On the page, drag the pointer where you want the button to appear.
4. Name the field and set General and Appearance properties.
5. Select Options and click Alignment. Select Right from the pull-down menu to align the values right.
6. Open the Format properties, click Select format category, and then select Number from the drop down menu.
7. Click Decimal places and type the number of decimal places you want to report in the calculated field.
8. Open the Calculate properties, and select Value type and do one of the following:
   • Click Sum (+) to sum a group of data.
   • Click Product (x) to multiply values.
   • Click average to average a group of field values.
   • Click minimum to report the minimum value among a group of fields.
   • Click maximum to report the maximum value among a group of fields.
9. Click the Pick option to open the Field Selection dialog box. Hold down the Control or Shift key and click each field you want to calculate.
10. Click OK.

12.12 JavaScript

To cover a complete description of JavaScript in Nitro PDF Professional is well beyond the scope of this user manual. In order to gain programming knowledge in JavaScript, you need to review sources you can find on the Internet, and books on JavaScript from local and online book resellers.

If you find learning by observation a method that works for you, you can find many PDF documents containing JavaScripts on the Internet. The most likely files supporting JavaScripts are PDF forms. You can download documents, open the JavaScripts in the Nitro PDF Professional JavaScript Console, and copy/paste routines in your own files. By examination, and trial and error, you can quickly learn some programming code.

12.12.1 Finding JavaScripts

Whether you write scripts in your own documents, or browse files for scripts to examine, you first need to
know where to look for JavaScripts. In Nitro PDF Professional you can find JavaScripts in the following locations:

- **Field scripts.** JavaScripts can be used with all field types. In all fields you can add scripts in the Set Actions properties. In signature fields you can add JavaScripts in both the Set Action properties and in the Signed properties. By far the most opportunity you have for adding scripts in field properties is with text fields. In text fields you can add scripts to:
  - **Format properties.** Open the Format properties and select Custom from the Select format category drop down menu. JavaScripts are added to create a Custom Format Script and Custom Keystroke Script.
  - **Validate.** Open the Validate properties and select Run custom validation script to add a JavaScript to validate field data.
  - **Calculate.** The Calculate properties are likely to be the most frequent area where JavaScripts are created. You can write scripts in two areas. Click the Simplified field notation button and you can write scripts using syntax similar to spreadsheet formulas. Click the Custom calculation script and you can write JavaScripts to calculate field data.
  - **Set Action.** Like the other fields, text fields support the Run JavaScript action type.

- **JavaScript console.** You can open the JavaScript Console and write a script that doesn't belong to any field or element. Scripts written in the JavaScript Console can be used to test routines and debug code.

- **Document Actions.** Opening, saving and printing PDFs are all document actions. JavaScripts can be written when these actions occur. To add a Document Action, go to the Forms ribbon tab, in the JavaScript group, click Document Actions.

- **Document level JavaScripts.** A document level JavaScript can be a function that other scripts call in subroutines. These scripts are contained at the document level and can be executed by another script or when opening a file.

- **Folder level JavaScripts.** A folder level JavaScript is located outside of the PDF file and can be used by more than one PDF. When Nitro PDF Professional is opened the scripts are run.

### 12.12.2 Copying and pasting JavaScripts

JavaScripts can be copied and pasted from one field or other location in a PDF document or between two documents. If you examine PDF files for learning JavaScript programming, you can browse PDF files containing scripts, copy a script from a document you download from the Internet, and paste the code into the JavaScript Editor in your document. With a little code modification, you can quickly add scripts to your own files.

To copy code between PDF files just open them both in Nitro PDF Professional.

### 12.12.3 Using folder level JavaScript

Folder level JavaScripts are JavaScript files (.JS) that are run during application startup. These can be useful for loading reusable JavaScript functions into the application, or accessing methods/properties whose security restrictions only allow them to be run in the app/init event.

Simple examples include loading the user's Windows login into a global JavaScript variable at startup, or loading a list of employee names from your company into a JS array at startup which can be used by the forms that are opened in Nitro PDF Professional.

**To add or edit a folder level JavaScript:**

1. Open Nitro PDF Professional.
2. On the Forms ribbon tab, in the JavaScript group, click Folder Level.
3. Add JS files to the folder or edit existing ones.

12.12.4 Writing document level script

You can use JavaScript to add an almost infinite number of interactive features, create complex calculation formulas, and add more dynamic functionality to your PDFs.

Document level scripts are used to add functions from which other scripts can reuse routines throughout a PDF file. You can also use document level JavaScripts to invoke actions when a file opens.

To write a document level JavaScript:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the JavaScript group, click Document Level.
3. Type a name for the script and click New.
4. In the JavaScript Editor dialog, enter your code. In the example below, a simple routine is created that opens an alert dialog box each time the file opens in Nitro PDF Professional. The code used is:

   var msg = "Created in Nitro PDF Professional"
   app.alert(msg)

5. Click OK. If your script was written properly, a dialog box should display each time the file is opened in Nitro PDF Professional.

12.12.5 Writing calculation scripts

Any form you create that requires calculations is likely to require custom calculation scripts. The options you have available with preset calculation formulas are limited to simple multiplication and addition. Other kind of calculation you need requires writing a script.

To write a calculation script:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, click Text Field.
3. Select the text field to edit.
4. Right-click and select Properties.
5. Click the Calculate tab.
6. Click the Custom calculation script option, and then click the Edit button.
7. Type the code for your script. In the example below, a simple routine is created to calculate sales tax at a 7.25 % rate. The code used is:

   var f = this.getField("subtotal");
   event.value = Math.round(f.value * 0.0725) / 100;

8. Click OK.

12.12.6 Using Simplified field notation

Simplified field notation is written more like formulas you add in spreadsheet applications like Microsoft Excel. Writing a notation is often an easier solution when adding calculation scripts.

To add a Simplified field notation:
1. Open the PDF in Nitro PDF Professional.
2. On the Form ribbon tab, in the Fields group, click Text Field.
3. Select the text field to edit
4. Right-click and select Properties.
5. Click the Calculate tab.
6. Click the Simplified field notation option, and then click the Edit button.
7. Type the code for your script. In this example, the same calculation for creating sales tax is added.
   The code in the JavaScript Editor is written as follows:
   \[ \text{subtotal} = \text{subtotal} \times 0.0725; \]
8. Click OK.

### 12.12.7 Using the JavaScript console

You can open the JavaScript Console and write a script that doesn't belong to any field or element. Scripts written in the JavaScript Console can be used to test routines and debug code.

**To use the JavaScript console:**
- On the Form ribbon tab, in the JavaScript group, click Console.

### 12.12.8 Viewing output and JavaScript errors

You can view output and JavaScript errors via the Output pane.

**To open the Output pane:**
- On the Home tab, in the Show/Hide group, click Output.

### 12.12.9 Supported JavaScript Objects

#### 12.12.9.1 App object

A static object that represents the Nitro PDF Professional application.

Contains methods and properties for interfacing with the application as well as some for working with active documents in Nitro Pro.

**Example:** Gets the number of documents open in Nitro Pro and displays it in an alert message.

```javascript
var nDocs = app.activeDocs.length;
app.alert("You have " + nDocs + " documents open.");
```

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>activeDocs</td>
</tr>
<tr>
<td>viewerType</td>
</tr>
<tr>
<td>viewerVersion</td>
</tr>
</tbody>
</table>
12.12.9.2 **Doc object**

Used for interfacing with open documents in Nitro Pro via JavaScript code.

**Example:** Retrieves full path of the PDF file and stores it in the variable sPath.

```javascript
var sPath = doc.path;
```
Methods

- addIcon
- addField
- addLink
- closeDoc
- deletePages
- extractPages
- exportAsFDF
- flattenPages
- getField
- getIcon
- getNextField
- getNextField
- getPageBox
- getPageNthWord
- getPageNumWords
- importAnFdf
- importIcon
- insertPages
- mailDoc
- mailForm
- print
- removeIcon
- removeField
- resetForm
- saveAs
- selectPageNthWord
- submitForm
12.12.9.3 **color object**

An object that can be used when setting a color in other JavaScript methods and properties.

**Example:** Sets the text color in the form field “First Name” to red.

```
this.getField("First Name").textColor = color.red;
```

**Properties & Methods**

The color object supports all properties and methods included in the Acrobat JavaScript specification.

12.12.9.4 **console object**

All JavaScript scripts are executed as the result of a particular event occurring. For each of these events, JavaScript will create an **event** object that can be used to get and update information about the current state of the event.

**Example:** Executing this JavaScript on the keystroke event will change any input from the user to uppercase.

```
event.change = event.change.toUpperCase();
```

**Properties & Methods**

The console object supports all properties and methods included in the Acrobat JavaScript specification.

12.12.9.5 **event object**

Represents a PDF form field, and this object contains methods and properties that provide a way to modify form fields (like you would visually with the form field tools) via JavaScript code.

**Example:** Changes a hidden field to be visible.

```
var oField = this.getField("hiddenFieldName");
oField.display = display.visible;
```

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>change</td>
</tr>
<tr>
<td>changeEx</td>
</tr>
<tr>
<td>commitKey</td>
</tr>
<tr>
<td>fieldFull</td>
</tr>
<tr>
<td>keyDown</td>
</tr>
<tr>
<td>modifier</td>
</tr>
<tr>
<td>name</td>
</tr>
<tr>
<td>rc</td>
</tr>
</tbody>
</table>
Field object

Represents a PDF form field, and this object contains methods and properties that provide a way to modify form fields (like you would visually with the form field tools) via JavaScript code.

Example: Changes a hidden field to be visible.

```javascript
var oField = this.getField("hiddenFieldName");
oField.display = display.visible;
```

### Properties

- alignment
- borderStyle
- buttonAlignX
- buttonAlignY
- buttonFitBounds
- buttonPosition
- buttonScaleHow
- buttonScaleWhen
- calcOrderIndex
- charLimit
- comb
- commitOnSelChange
- currentValueIndices
defaultStyle
defaultValue
doNotScroll
doNotSpellCheck
display
doc
editable
exportValues
hidden
fileSelect
fillColor
lineWidth
highlight
multiline
multipleSelection
name
numItems
page
password
print
radiosInUnison
readonly
rect
required
richText
richValue
rotation
strokeColor
style
submitName
textColor
Methods

browseForFileToSubmit
buttonGetCaption
buttonGetIcon
buttonImportIcon
buttonSetCaption
buttonSetIcon
checkThisBox
clearItems
defaultIsChecked
deleteItemAt
getArray
getItemAt
getLock
insertItemAt
isBoxChecked
isDefaultChecked
setAction
setFocus
setItems
setLock

12.12.9.7 global object

Allows you to share data across an instance of the Nitro Pro application (i.e. data can be accessed from within any of the open documents).
Example: Once a user has entered their email once, store it in a global variable and auto-fill email fields in the other open documents.

```javascript
global.userEmail = this.getField("email").value;
```

Note: The setPersistent and subscribe methods are not currently supported in Nitro Pro.

12.12.9.8 identity object

This object holds information about the current user who is logged onto the machine using Nitro PDF Professional. You can view this information in Nitro Pro preferences as well.

Example: This JavaScript gets the login name of the user and stores it in a global variable (called `login`) that can be used by any other JavaScript. Because the identity object is only permitted during the console, menu, application initialization and batch events, this would be ideal to be in a folder level JavaScript file (.js) that was executed when Nitro Pro starts.

```javascript
global.login = identity.loginName;
```

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>corporation</td>
</tr>
<tr>
<td>email</td>
</tr>
<tr>
<td>loginName</td>
</tr>
<tr>
<td>name</td>
</tr>
</tbody>
</table>

12.12.9.9 Link object

This object allows you to get and set the properties of a PDF link, as well as set a 'Run a JavaScript' action.

Properties & Methods

The link object supports all properties and methods included in the Acrobat JavaScript specification.

12.12.9.10 this object

Is a special keyword used in JavaScript that refers to the current object. For example, when running JavaScript when a document is open, using the `this` keyword is the same as using the `doc` keyword.

Example:

```javascript
this.getField("fieldname");
```

would be the same as:

```javascript
doc.fieldName("fieldname");
```
Properties & Methods
The this object supports all properties and methods included in the Acrobat JavaScript specification.

12.12.9.11 util object
Contains a number of helper/convenience methods for string and date formatting and parsing.

<table>
<thead>
<tr>
<th>Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>printf</td>
</tr>
<tr>
<td>printd</td>
</tr>
<tr>
<td>printx</td>
</tr>
<tr>
<td>scand</td>
</tr>
</tbody>
</table>

13. Shortcuts

- Viewing
- Navigating
- Editing
- File
- Tools

13.1 Viewing

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Page</td>
<td>Display the document one page at a time.</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Continuous</td>
<td>Display the pages in a continuous vertical column to scroll through the document like a web page.</td>
<td>Ctrl+4</td>
</tr>
<tr>
<td>Continuous Facing</td>
<td>Display the pages in a continuous two-page vertical column.</td>
<td>Ctrl+5</td>
</tr>
<tr>
<td>Facing</td>
<td>Display the document two pages at a time as page spreads.</td>
<td>Ctrl+6</td>
</tr>
<tr>
<td>Actual Size</td>
<td>Zoom the document so it is displayed at its real size.</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Fit Width</td>
<td>Zoom the document so that the width</td>
<td>Ctrl+2</td>
</tr>
</tbody>
</table>
13.2 Navigating

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Page</td>
<td>Go to the first page in the document.</td>
<td>Home</td>
</tr>
<tr>
<td>Last Page</td>
<td>Go to the last page in the document.</td>
<td>End</td>
</tr>
<tr>
<td>Previous Page</td>
<td>Go to the previous page in the document.</td>
<td>Left arrow</td>
</tr>
<tr>
<td></td>
<td>Zoom the document so that the entire page fits in the document window.</td>
<td>Ctrl+0</td>
</tr>
<tr>
<td>Next Page</td>
<td>Go to the next page in the document.</td>
<td>Alt+Right arrow</td>
</tr>
<tr>
<td>Previous View</td>
<td>Retrace your previous viewing path, including movements between pages, magnification levels, and via bookmarks and links.</td>
<td>Ctrl+,</td>
</tr>
<tr>
<td>Next View</td>
<td>Retrace your viewing path, including movements between pages, magnification levels, and via bookmarks and links.</td>
<td>Ctrl+.</td>
</tr>
<tr>
<td>Scroll Up</td>
<td>Move up the page.</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>Move down the page.</td>
<td>Down Arrow</td>
</tr>
</tbody>
</table>

13.3 Editing

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Text &amp; Images</td>
<td>Select text and images and then edit them. Double-click on text to select and edit it.</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Edit Links</td>
<td>Shows all hyperlinks in the document. Select, edit, align, and delete them.</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Edit Forms</td>
<td>Shows all form fields in a document when in Form Assistant mode. Select, move, edit, align, and delete them.</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Insert Page</td>
<td>Insert extra pages or whole documents into</td>
<td>Shft+Ctrl+I</td>
</tr>
</tbody>
</table>
the PDF file.
Files, such as Microsoft Office files, can be converted and then inserted in the one step.

Delete Pages  Delete pages from the PDF file.  Shft+Ctrl+D
Extract Pages  Extract pages from the file to create a new PDF file.  Pages can also be removed and extracted from the current file at the same time.  Shft+Ctrl+E
Split File Pages  Extract a range of pages from the PDF file.  Split the document via page number, page range, bookmarks and more.  Shft+Ctrl+P
Rotate Pages  Rotate one or more pages in the file.  Shft+Ctrl+R
Bookmark  Add a bookmark to the file to make it easier to find this page in the document.  Ctrl+B

13.4 File

<table>
<thead>
<tr>
<th>Feature</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As</td>
<td>Alt+F+A</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Close All Documents</td>
<td>Ctrl+Shft+W</td>
</tr>
<tr>
<td>Move to next open document</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Move to previous open document</td>
<td>Ctrl+Shft+Tab</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Document Properties</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Create</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Combine</td>
<td>Shft+Ctrl+N</td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F</td>
</tr>
</tbody>
</table>
## Tools

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hand</td>
<td>Use the Hand tool to grab and move the page around when not all parts of the page is displayed.</td>
<td>Esc, Ctrl+H</td>
</tr>
<tr>
<td>Copy Text</td>
<td>Select text from the page and paste it into another text editing application. Click and drag the mouse to select text.</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Page Area Snapshot</td>
<td>Select part of the page as a snapshot or picture that you can paste into other applications. Click and drag the mouse pointer to select the snapshot area.</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Edit Text &amp; Images</td>
<td>Select text and images and then edit them. Double-click on text to select and edit it.</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Edit Links</td>
<td>Show all hyperlinks in the document. Select, edit, align, and delete them.</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Edit Forms</td>
<td>Show all form fields in a document. Select, move, edit, align, and delete them.</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Click on an area of the page to zoom in on it. To switch to Zoom Out hold down Control.</td>
<td>Ctrl+J</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Click on the page to zoom out to a larger area of the page. To switch to Zoom In hold down Control.</td>
<td>Ctrl+K</td>
</tr>
</tbody>
</table>